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1 Organizer

Organizer is a daily tool for managing model information, object property
queries, and object classification. Using Organizer, you can access all model
information, including IFC information, in one place, and manage your model
information effectively. Organizer is an efficient tool at any stage in the
construction and design process for designers, detailers, managers,
estimators, contractors, or anybody using the model information.

For example, construction managers can view and report on key properties of
parts and groups of parts of the Tekla Structures model, such as the quantities
of purchasing packages. Designers can instantly check object, assembly, or
cast unit properties during design to ensure that the properties are as they are
intended to be. For example, by creating categories it is easy to automatically
track precast or steel elements that are too heavy, reinforcing bars that are too
long, and status info.

You can synchronize Organizer with the model to get instant feedback on
what is changing in the model and create reports on demand.

Organizer consists of two tools:

+ Use Object Browser to instantly view and create reports on model
information based on the selections you make.

+ Use Categories to define building locations to automatically arrange model
objects and visualize the locations in the model. You can also create
categories based on different properties and write user-defined attributes
to objects based on the categories the objects belong to. You can use filters
to automatically update the category content whenever there are changes
in the model. You can also manually change the content of categories.

See also

View object properties in Organizer (page 6)

Report object property values from Organizer (page 18)
Create a property template in Organizer (page 22)
Create a color set in Organizer (page 29)

Import a property template to Organizer (page 31)
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Export a property template from Organizer (page 31)
Categories in Organizer (page 32)

Synchronize Organizer with the model (page 57)
Export a category from Organizer (page 61)

Import a category to Organizer (page 63)

Import IFC categories to Organizer (page 65)
Organizer in the multi-user mode (page 65)

Example: Organize the model into location and custom categories, and view
quantities (page 66)

Example: Track modeling and planning issues using Organizer (page 78)

Example: Add a classification code to objects in Organizer and export the code
to IFC (page 108)

Example: Create a custom category for structural design status in Organizer
(page 114)

Example: Create a custom category for architectural design status in Organizer
(page 115)

Example: Organizer for steel - manage bolts (page 118)
Example: Organizer for steel - manage assemblies (page 120)
Example: Organizer for precast (page 121)

View object properties in Organizer

You can view the properties of selected model objects in Object Browser.
Object Browser lists the objects that you have selected in the model or the
objects of the categories you have selected. The object properties are shown in
columns. You can change the order and sorting direction of the columns, and
group the properties to view the object data in a structured way.

Click Reload the view £ in Object Browser when you want to view the latest
property values from the model. Once you have viewed a property of any
object, the property will be updated in the Organizer database at
synchronization.

NOTE Synchronizing Organizer < updates all properties of the changed
objects in the Organizer database. You do not need to reload Object
Browser if you change the selection in the model, or select another
category or another property template. When you have synchronized
Organizer, the object properties are up to date until you make
changes in the model.
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You can use Tekla Structures selection switches to select the needed objects in
the model, select assemblies , for example.

To view object properties in Organizer:
1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select model objects in the model, or a category in Categories.

3. Reload & Object Browser to show the latest object property values.

View the objects selected in the model or the objects of a
category

On the Object Browser toolbar, the automatic selection is selected by
default. Object Browser automatically shows objects either from the model or
from the categories. If you have a category selected, Object Browser only
shows the objects that are in the category. If you have selected objects in the
model, Object Browser only shows these objects.

You can switch off the automatic selection if you want to control whether
objects are shown from the model or from the categories:
1. Click to activate the other selection buttons.

2. Select the option you want to use:
«  Click o to show objects from the model.

« Click = to show objects from the categories.

Note that the objects of a selected category are by default not highlighted or
selected in the model.

To view the objects of a selected category in the model, select either Select
objects in the model or Highlight objects in the model from the list at the
bottom of the categories.

Set the limit for the number of objects shown in Object
Browser

Object Browser may not automatically show the objects you selected in the
model or in a category. There is a predefined limit for the number of objects
shown in Object Browser. If the number of objects you have selected is above
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the limit, Object Browser shows you how many objects you have selected and
what the limit for showing the objects is.

Do any of the following:

+  Click === to show the objects.

Object Browser shows the objects and the object properties stored in the
Organizer database.

el

¢ Click ==

Object Browser shows the objects and the object properties that have
been updated in the model.

| to reload the object properties and to show the objects.

+ Change the predefined limit by entering a number in the box, for example
6000 EEE
. Then click (mmmm_
The number you enter in the box becomes the default limit for showing
objects in Object Browser.

+  Make another selection.

You can also set the limit in Organizer Settings. Click L in the upper-right
corner of Organizer and go to the Synchronization tab.

View another property template

Select another template from the template list to view the same object
selection with a different template.

i f ﬂ Rebar "]

Set the default property template

1. Click = in the upper-right corner of Organizer to open the Settings.
2. Select a template from the property template list and click Set as default.
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3. Click Modify to save your selection.

The Set as default button is hidden when you have the default template
open. When you select another template, the button is shown again.

Pin the current template in Object Browser
Pinning a template holds the selected template visible in Object Browser.

When you pin a template and select different categories to view the model
objects in Object Browser, the pinned template is shown even if the selected
category has another template defined for it. This is useful if you want to
compare different categories using a certain template.

1. CIickJe,to pin the current template in Object Browser.

You can still select another template from the template list. Pinning always
keeps the latest selected template visible.

Click to release the template.

Group object properties

1. Click = and select Groupt::.
Object Browser displays a grouping row.

2. Select a property column heading and drag the column to the grouping
row.

3. Click ‘= and select GroupE to hide the grouping row.

For more information, see Group object properties in Organizer (page 13).

Show assembly content

1. Click = and select Show content &8 to show the objects in the
assemblies, cast units or pour units that are currently listed in Object
Browser.

The assembly, cast unit or pour unit hierarchy levels are shown in
different shades of blue.
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Click “=_ and select Show contentE:'I to hide the assembly content.

The assembly, cast unit and pour unit hierarchy levels are also removed
when you sort and group objects in Object Browser. The objects shown
in Object Browser remain the same.

Combine identical rows

You can combine the rows that have the same property values in the Object
Browser view. When you combine the rows, Object Browser displays a Count
column that shows how many rows have been combined.

You can also select whether to show a single property value or the sum of the
property values in a column. The sum of the values is the single value
multiplied by the number of combined rows.

1.

Click ™= and select Combine identical rows =,

Combined rows are shown even if you select another category in
Categories.

If needed, click Modify to include the combined rows in the property
template.

To show the sum of the property values in a column, click Lo in the
upper-right corner of Organizer to open the Settings, locate the
property under Columns and set the In combined row show option to
Result.

Click *=_ and select E to remove the combined rows.

Show calculated results of object property values in the
sum row

1.

Select whether Object Browser calculates the results from all or selected
FOWs.

(Al v
Al

Selected

Select whether Object Browser shows the calculated total, average,
minimum or maximum values.
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Total b

Total
Average
Minimum

Maximum

For more information, see Calculate property values in Organizer (page 16).

Use colors to visualize Object Browser groups in the model

5.

Click (= and select Group =,

Select a property column heading and drag the column to the grouping
row.

Click “=- and point the Color set command.
Object Browser lists the color sets that are available.

Click the Group command to select the current set, or select a suitable
color set from the sets that are available.

Click 2= and select a command other than Group to remove the colors.

Organizer assigns colors to the groups shown in Object Browser. The
topmost group in Object Browser gets the first color in the color set, the next
group gets the second color, and so on. The objects on the lowest group levels
are shown in the model using the assigned color.

For more information, see Create a color set in Organizer (page 29).

View categories, and unions and intersections of categories

1.

2.

Select more than one category in the category tree.

Click (= and select any of the following;:

. A Automated is the default.

Automated shows the union of the object content of categories that
are under the same category root and the intersection of the object
content of categories that are in different category roots.

]
« | ® Separate categories shows the objects per category.
Automated adds the category structure to Object Browser.
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Union of categories

Object Browser shows the union of the object content of the selected
categories.

. @
Intersection of categories

Object Browser shows the intersection of the object content of the
selected categories.

You can also click /= at the bottom of Categories. The selection pane shows
either a union or an intersection of the selected categories, depending on
what you have selected. Drag categories between the boxes to modify the
unions and intersections.

When you view unions and intersections using the selection pane, ensure that

|
the Show the categories in Object Browser . ® button is not active.

List the categories of objects
1. Select one or more rows in Object Browser.
2. Right-click and select List the categories.

The category list shows all the categories that contain at least one of the
selected objects.

3. Click a category in the list to highlight the category in Categories.

Hold the current view in Object Browser and remove
objects and categories from the view

1. Click ™= and select . X 'to hold the current view.

Your new selections in the model or in the categories are added to the
Object Browser view.

2. Remove objects and categories from the view:

« To remove an object, right-click a row and select Remove from the
view.

= u .
« Toremove a category, click == and select . ® Separate categories.
Right-click the category and select Remove from the view.

3. Click “= and select £4¥ to release the view.
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Select the command buttons shown in Object Browser

1. Click = in the upper-right corner of Organizer to open the Settings.
2. Go to the Toolbar tab.
3. Select the buttons that you want to show on the Object Browser toolbar.

Settings b4
Property templates Units Synchronization Colors
Show on the Object Browser toolbar

Color sets

Group

ar
3:3 Show content

J &

B3 Combine identical rows

® Manage manual changes

& L] [&]

I= Export
A Automated

s
— @ Separate categories
i . Define how the content of the selected categories is shown in Object Browser
‘ Union of categories

% Intersection of categories

v £ Hold the view

4. Close the Settings dialog box.

Change the order of columns

Select a property column heading and drag it on the column heading row to
the desired location.

Change the sorting direction
1. Click a column heading to show the sorting direction.

The default direction is ascending. You can change the default direction in

the Settings, click = in the upper-right corner of Organizer.
2. Click the column heading again to change the sorting direction.

See also
Set the units in Organizer (page 17)
Categories in Organizer (page 32)
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Group object properties in Organizer

You can sort the objects shown in Object Browser by grouping the objects
based on their properties. You can group object properties both in Object
Browser and in Organizer Settings. The grouping you define in Settings is
used in a property template when you save the template.

1.
2.

To open Organizer, click Manage on the ribbon and then click Organizer.

Select objects in the model or select a category to view the objects in
Object Browser.

Click “=_ and select Group.
Drag one or more property columns to the grouping row.

The objects are grouped according to the order of properties in the
grouping row, from left to right.

In the Organizer Settings, the grouping row is always available. To open

the Settings, click = in the upper-right corner of Organizer.

When you group object properties in the Settings, the grouping is
simultaneously shown in Object Browser if the grouping row is visible.

In the example below, the first grouping level is Name, the second level is
Material, and the third level is Profile.
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& Organizer

i
m

- f [DQ}‘auEt - | Mc

[S—

1 3
MName & X Materiale X Profile & X

Content ty &« Material type | Position number

- BEAM (11)
1
- C30/37 (1)
2
- 600*400 (1)
3
PART CONCRETE  Concrete_B-1/15
- $2351R (10)
2
- L5073 (10)
3
PART STEEL b/21
PART STEEL b/21
PART STEEL b/21
PART STEEL b/21
PART STEEL b/21

5. Do any of the following:

a. Drag the object properties in the grouping row to change the
grouping order.

b. Click an object property in the grouping row to change the sorting
direction.

c. Click Remove grouping * to remove an object property from the
grouping row.

You can also drag the object property back to the column headings
row. When you drag the property, it is placed to the location where
you drag it to.

6. Click Modify to include the grouping to the template.

7. To permanently save the grouping to the template, save the Tekla
Structures model.

TIP When you have grouped objects in Object Browser, you can create a pie chart
to view the ratio of the number of the objects included in the groups. Press Alt +
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F12 to create the pie chart. You can copy the pie chart to any document by using
the Ctrl + C and Ctrl + V copy commands.

See also
Create a property template in Organizer (page 22)

View object properties in Organizer (page 6)

Calculate property values in Organizer

Object Browser shows the calculated total, average, minimum or maximum
object property values in a sum row. You can select which values are shown,
and whether the values are calculated from all the rows or from the rows you
have selected in Object Browser.

Click Reload the view € in Object Browser when you want to view the latest
property values from the model. Once you have viewed a property of any
object, the property will be updated in the Organizer database at
synchronization.

NOTE Synchronizing Organizer < updates all properties of the changed
objects in the Organizer database. You do not need to reload Object
Browser if you change the selection in the model, or select another
category or another property template. When you have synchronized
Organizer, the object properties are up to date until you make
changes in the model.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select objects in the model or select a category to view the objects in
Object Browser.

3. Select whether Object Browser calculates the results from all or selected
FOWs.

(Al v
Al

Selected

All is the default.
4. Ifyou select Selected, select the rows in Object Browser.
5. Select a value option from the list:

Organizer 16 View object properties in Organizer



Total b

Total
Average

Minimum

Maximum

The values are shown at the bottom in the sum row. The value is the
rounded result of the precise object property values.

NOTE By default, Object Browser shows the calculated values of properties for
which it is useful to calculate results. If you do not want to show the calculated

e

value of a property, click in the upper-right corner of Organizer to open

the Settings and set the In sum row show option to - . Reload 2 the Object
Browser view.

Width ‘ Ascending _Unit_ x
In sum row show [ - v]
In combined row show [ ) ]
Single value
WIDTH x Result
See also

View object properties in Organizer (page 6)
Set the units in Organizer (page 17)

Set the units in Organizer

The default units in Tekla Structures depend on the settings in File --> Settings
--> Options --> Units and decimals . You can change these default settings in
Organizer to view a different unit system, unit type, and precision in Object
Browser and in Categories.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

Click = in the upper-right corner of Organizer to open the Settings .
Go to the Units tab.
Select a unit system from the list.

ik W

Select a unit from the list.
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6. Select a precision from the list.

Use the precision option for Others if you want to define the precision for
quantities other than distance, area, volume, or weight.

NOTE You can set the unit of an individual property column in Organizer Settings

L by clicking ! in the column. These individual settings override the
Units tab settings. Individual settings are useful if you want to show the
length in imperial and metric units in one template, for example.

Unit

See also
View object properties in Organizer (page 6)

Calculate property values in Organizer (page 16)

Report object property values from Organizer

You can export object property values from Object Browser to Microsoft Excel
for further processing. The property columns in Object Browser are exported
exactly as they are shown. You can use predefined default Excel templates, or

you can create your own Excel templates for the export.

Ensure that you have Microsoft Excel installed on your computer.

If you want to create your own templates, first create a
\ProjectOrganizerData\ExcelTemplates folder under the current model
folder, project folder, firm folder or system folder, and save the templates

there. This way you can select your template from the list of available
templates in the Export data to Excel dialog box.

TIP - If you want to place the object properties to a certain location in the
Excel template, modify the template by typing $s0%s to the cell from
which you want data placement to start, and save the template.

* You can also define in the Excel template how the summary rows are
shown: either above or below the object rows. Go to the Data tab in
the Excel template, click the small arrow in the Outline area

Outline =, select the needed setting, and click OK. Then
save the template.
1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select objects either in the model or in the categories to view the objects
and their properties in Object Browser.

3. Select a suitable property template.

4. Click = and select Export.
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Select an Excel template from the list of available templates, or click
Browse to select another template.

If you do not select a template, a default Excel template is used in the
export.

Object Browser lists all the Excel templates that are available for the
export in the following folders:

* Current model folder

* Project folder (xS PROJECT)

* Firm folder (xs_FIRM)

+ System folder (xs_SYSTEM)

Select one or more export options:

+ Update object properties from the model is selected by default.

The latest object properties from the model are updated to Object
Browser for the export.

+ Export without column headers

Select whether to export without the Object Browser column header

line.

This option is useful if you have predefined column headings in the
Excel template.

« Export only summary rows
Select whether to only export Object Browser summary rows.
Click Export.

Microsoft Excel opens automatically. Grouping, combined rows, and
calculated values (total, average, minimum and maximum) are also
exported.

Example: Export project properties

You can automatically include any project property to the object property
export. You can do this by creating a separate property template for the
project properties and naming it asw Project data.

NOTE YoumustuseW Project data asthe name of this template.

Define the project properties in File --> Project properties . In this
example, you enter the project name, project builder, and a project
comment in the user-defined attributes.

Organizer 19 Report object property values from Organizer



Project properties
General

Project number 1

MNarme Trimble Solutions Corporation
Builder Builder
Object

Designer

Location

Address

Pastal box

City

Sl iy

Region

Pastal code

Country

Start date

EE

End date
Info 1
Info 2

Description (078

GUID: 3dbc0285-88fe-4019-924a-660a390403d7

Base points

Location by

Model origin b

Base points

Attributes

User-defined attributes

In Organizer, create a property template (page 22) for the project
properties you defined above. In this example, you only add the project
properties to the template.

You can add any properties in the template. Note however that Organizer
will add to the report the first random value that it finds for the property.
Therefore, add in the template only such properties that have the same
value for all objects. For example, you can add PHASE to the template if all
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the objects you intend to include in the report are going to belong to the

same phase.

a. Click & in the upper-right corner of Organizer to open the Settings

and click Template.

b. Name the template aswWw Project data and select Blank template.

Click Create.

d. Dragthe PROJECT.NAME, PROJECT.BUILDER and
PROJECT .USERDEFINED.PROJECT COMMENT project properties to

the property columns.

e. Click Modify to save the template.

Settings

Units Colors Toolbar

Property template W _Project_data

Synchronization

Properties
[ PROJECT

st to the columns on the right.

Y

PRO.
PROJECT.NAME

T.MODEL

PROJECT.OBJECT
PROJECT.US|
PROJECT.US
PROJECT.USERDEFINED.PROJECT_USERFIELD 2

INED.PROJECT_COMMENT

_USERFIELD_1

.__x Modify  Set as default _+ Template

4+ Custom~

Group: |All -

>
Import_Export
Color set: | Default ~
Columns l
PROJECT.NAME 4 Ascending x
PROJECT.NAME x

PROJECT.BUILDER

PROJECT.BUILDER x

PROJECT.USERDEFINED.F »

PROJECT.USERDEFINED PROJECT_COMMENT X

Add the project properties to the Excel template that you are going to use

in the export and save the template.

You can copy the column headers from the property template and add
them anywhere in the Excel template, see an example below.

& Tekla
Structures
FOBax 1, Sreed sodress 1, 12345 Cty 1

T 596 1204567, Fa 555 864321
Emal trs zsghcongany con

Brogect rame: Eroject number |

[PROJECT NAME

e |PROJECT BUILDER

P sddtess. | L |

|PROJECT.USERDEFINED.PROJECT_COMMENT

NOTE If you add a DATE type of property to the Excel, change the format
of the Excel cell to Date to show the date correctly. A DATE type of
property is a property that has DATE in the name.
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1.3

NOTE If you want to add the DATE property to your property template to
add the current date, you have to change the name of the column
header to be something different than DATE. For example, change
it to DATE1, and use the same text (DATE1) in the Excel template.

4. Export object properties and project properties from Organizer.

a. Select objects in the model or categories to view the objects in Object

Browser.

b. Select a property template that you want to use in the export, for
example, Default or Rebar.

c. Click ™= and select Export.

d. Select the Excel template you modified previously and click Export.

The values of the project properties that you added to the Excel template
are shown in the exported Excel.

& Tekla

Structures

F0.80x 1, Srest address 1, 12345 Cay 1

Frojec name:

Tel 555 1234557, Fax 555 7654321
Emal fr= lasomoany com

Emat g
Trimble Solutions Curporalion]

Frojectm

umber

Project addness

it date

|Fevsion, oam: |

Count Name Content type Material type Material Height/mm Length /mm

3 BEAM PART
1 BEAM PART
1 BEAM PART
2 BEAM PART
7 COLUMN PART

Total

All objects in the table:
14

See also

Export a property template from Organizer (page 31)

STEEL
STEEL
STEEL
STEEL
STEEL

5235JR
8236JR
S5235JR
S235JR
5235JR

290
290
290
290
390

6000
5664
3156
3000
7200

83220

Width /mm Volume /m3 Weight /t Phase

300
300
300
300
300

e [[Builder 1

||New comment |
01 0,53 1
01 0,5 1
[¢] 0,279 1
0 0.265 1
01 0,899 1

1,2 9,189

Create a property template in Organizer

You can create property templates in Organizer to view the properties of
selected model objects in Object Browser. For example, you can create
templates for different object types and object groups, and include the needed
object properties in the template. You can group and sort the properties in the
template. You can also modify existing templates.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click = in the upper-right corner of Organizer to open the Settings.

Organizer
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If you want to create the new property template based on a current
template, select the template from the list of templates.

You can modify an existing template by selecting it from the list of
templates and changing the properties included in it.

CIick: + Template '.

Enter a unique name for the property template.
Create is dimmed if you enter the name of an existing template.

Select whether the template is created based on the current template or
as a blank template.

Click Create.

Property templates are saved to the ProjOrg database in the
\ProjectOrganizer folder in the model folder. The saved property
templates are shown in the property template list.

Do any of the following to define the properties that are included in the
template:
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. — 10 .
Position number & X 5 Colorset. |Default ~

Drag columns here to form groups.

Columns 1 +
|Position number 2 | Ascending & = 5 6 x
In sum row show [ - hd l
|PART_POS X | OR |ASSEMBLY_POS | OR | CAST_UNIT_POS X |
OR |PRIMARY.PART_POS X | 3
|New column 2 | Ascending X
In sum row show [ - hd l
‘ Drag and drop one or more properties here. 3
|Vo|ume 2 | Ascending Q9 Unit X
Insum row show  f [Result A l
In combined row show 8 [Single value vl
vomex| 3
Option in Description
image
1 Create a new property column.
2 Enter a name for a new property column or rename a property
column.
3 Drag one or more object properties from the list of properties to

a property column.

The properties are read from the environment.db file in the
model folder.

If you need properties that are not available in the list, for
example reference model object properties, you can create them
in Organizer as custom properties (page 26).
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Optionin Description
image

You can use the search box to easily find the relevant properties.

In the Group list, you can select an option to show only certain

properties, for example:

+ Select Recent to view the most recently used and created
properties.

+ Select Custom to view imported properties and the
properties you have created in Organizer.

« Select Property templates to view the properties that are
used in the property templates of your model.

4 Click Ascending or Descending to change the sorting order in a
property column.
5 Drag a property column to the grouping row. The grouping icon

*= is shown in the property column.

6 Delete a property column.
7 Select the property value shown in the sum row in Object

Browser:

* - (minus) does not show any value.

+ Single value shows a single property value. The single value
is shown if all the objects have the same property value in the
column.

« Result shows the sum of all the property values in the
column.

8 Select the property values shown in combined rows in Object

Browser:

+ Single value shows a single property value.

+ Result shows the sum of the property values.

9 Click \Y to set the unit and the precision of the unit for a
property column.
10 Select a color set (page 29) for the template.

9. C(Click Modify to save the properties to the template.

10. To permanently save the template and the changes you have made to it,
save the Tekla Structures model.

Example of using multiple object properties

It can be useful to have multiple object properties in one column. This way you
can ensure that the relevant property value is found for different object types.
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For example, you can include different name properties in the Name column.
Object Browser shows NAME for parts, ASSEMBLY NAME for assemblies,
CAST UNIT NAME for cast units, and so on.

‘Name ‘AAscending x

In sum row show | - A |

'NAMEX | OR |ASSEMBLY_NAMEX| OR | CAST_UNIT_NAME X |

OR |BOLTNAMEX OR |NUTNAMEX OR |MAINPART.NAME X |

When searching for the properties, Object Browser uses the order, from left
to right, in which the properties are shown in the column. Once a value is
found, the rest of the properties in the column are ignored.

See also

Create a custom formula in Organizer (page 27)

Create a custom property in Organizer

You can create your own properties in Organizer and use these properties in
property columns in the same way as any other properties. If you want to use
the properties in the model, you can add them to the model objects in
property categories.

Some object properties, for example, the properties of reference model
objects are not automatically available in Organizer. To use these properties
in Organizer, create them as custom properties.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

Click = in the upper-right corner of Organizer to open the Settings .
Click Custom.
Select Property.

vk W

Enter a name for the property in the Name box.

This name is shown in the list of properties. Ensure that there are no
space characters before or after the name.

6. Enter the exact name of the property in the Property box.
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Organizer uses this name to search for the property value. Ensure that
there are no space characters before or after the name. For UDA type
properties, the maximum length is 19 characters.

NOTE For reference model object properties you must add EXTERNAL.
at the beginning of the property name, for example,
EXTERNAL.Tekla Reinforcement.Rebar Mark.You can copy
the exact name of the property from the Inquire object dialog
box, for example.

7. Select a unit type for the property.

Organizer automatically selects the default Data type value of the unit
type. You can change the data type.

8. Select a data type for the property.
9. Select a property type for the property.

Use UDA when creating properties that you write to the model.

Settings >
Units Synchronization Colors Toolbar
Praperty template Default ~| X Modify Setasdefault + Template Import  Export
Color set: | Default =
Properties Columns +
Group: |All
- Name - Ascending x
e S e TS e R T TR
- show -
Create Property Y

DA OR | ASSEMBLY_ MAMEX| OR  CAST_UNIT_NAME x
LTNAMEX OR |NUTNAMEX| OR |MAINPART.NAME X

Unit type Data type Property type

ype &
No unit ¥ | | Number without decimals ~ | |UDA

OK  Cancel
= ——— TTYPEX| OR |PART.CONTENTTYPE X

10. Click OK.

Custom properties are shown in the list of properties in the Custom group.
UDA properties are also shown in the UDA group. You can modify and delete
custom properties by right-clicking the property.

See also
Create a property template in Organizer (page 22)

Create a custom formula in Organizer

You can create simple mathematical formulas using the object properties that
are available in Organizer. You can, for example, calculate areas of specific
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object types. You can add formulas to property columns in the same way as
object properties. You can also use formulas in the object properties when
creating property categories.

1.

2
3
4,
5

To open Organizer, click Manage on the ribbon and then click Organizer.

Click L in the upper-right corner of Organizer to open the Settings .
Click Custom.

Select Formula.

Enter a name for the formula.

Ensure that there are no space characters before or after the name.

Enter a property name in the search box in the Settings dialog box to find
a property.

You can also select an option from the Group list to narrow down the
selection of properties shown in the list of properties.

Drag the needed properties to the formula box in the Create Formula
dialog box.

Drag the needed mathematical operators to the formula box and place
them between the properties.

+||-|f
. |—| — |—| —' to add the main mathematical operation signs.

e

. [JD)

to add parentheses.

#
. |—| to add a box where you can enter a number.

Edit formula X

Name: |Rebar weight per concrete volume ‘

| CAST_UNI'I'.CAST_UNIT_REBAR_WEIGHT)‘| | / | | CAST_UNIT.VOLUME_ONLY_CONCRETE_PARTS X

Unit type

‘:No unit hd

Apply Cancel
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9. If needed, drag the properties and operators inside the formula box to
modify the formula.

Organizer automatically checks whether the formula is mathematically
correct. If the formula is not correct, Create is dimmed and the incorrect
parts are shown in red.

10. Select a unit type that is suitable for the properties used in the formula.
11. Click Create.

The formula is shown in the list of properties in the Custom group. You can
modify and delete custom formulas by right-clicking the formulas in the list of

properties. You can use custom formulas in property templates by dragging
the formulas to property columns.

Praperties + Custom~ | Columns

|Graup: Custom -

i I
Edit formula x Unit x

MName: [:{t-i ar weight per concrete volume

<[] 12 [=] L] o] |
iTx

CAST_UNIT.CAST UNIT REBAR WEIGHT X | | /| | CAST_UNIT.VOLUME ONLY CONCRETE_PARTS X

Unit type

No unit A

Apply  Cancel

LAMS STATUS

Rebar/volume (kg/m3) Unit x
Show result in sum row
D Show result in combined rows

Rebar weight per concrete volume X

See also
Create a property template in Organizer (page 22)

Create a color set in Organizer

You can use colors to visualize the content of Object Browser groups in the
model. The colors are included in color sets that you can create and modify.
You can include a color set in a property template so that a property template
always uses certain colors. The color visualization is for viewing purposes. You
cannot save the colors in the model or in Object Browser.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click L in the upper-right corner of Organizer to open the Settings.
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TIP

Go to the Colors tab.
Click |7 Color set .

The color set is created based on the set that is currently selected.
Enter a unique name for the color set.
Click Create.

Do any of the following to define the colors that are included in the color
set:

+ Double-click a color to modify it.
+ Drag the colors to arrange them to a different order.

The colors are used in Object Browser in the order in which they are
listed in the color set. The topmost group in Object Browser gets the
first color, the next group gets the second color, and so on.

+ Right-click a color and select to add, delete, cut or copy the color.
+ Double-click an added color to modify it.

You can select multiple colors by using the Ctrl and Shift keys.
+ Click Reset colors to restore the colors of the Default set.

If needed, click Set as default to use the color set as the default set in
Organizer.

Click Modify.

Organizer keeps the settings you have defined in the new color set. If you
do not click Modify and close the Settings dialog box, the new color set
has the same settings as the color set you used as a basis for the new set.

You can export color sets from Organizer in the xm1 format and use the sets in
other models. You can export one set at a time. The color set file has
the .colorset file extension.

You can import color sets that have been exported from the current model or
other Tekla Structures models as in the xm1 format. You can import several files
at atime.

See also

Create a property template in Organizer (page 22)

View object properties in Organizer (page 6)

Delete a property template in Organizer
You can delete property templates in Organizer Settings.

1.

To open Organizer, click Manage on the ribbon and then click Organizer.
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2. Click L in the upper-right corner of Organizer to open the Settings .

3. Select a property template from the list of templates.

4. Click % to delete the selected property template.

See also

Create a property template in Organizer (page 22)

Import a property template to Organizer

You can import to Organizer property templates that have been exported
from the current model or other Tekla Structures models. Property templates
are in the xm1 format. You can import one or multiple templates at a time.

You can save the property templates to a \ProjectOrganizerData system
folder to make them automatically available in all models. For information on
how to use the firm, project and system folders with Organizer, see
Customized default setup for Organizer (page 55).

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click = in the upper-right corner of Organizer to open the Settings .
3. Click Import.

Select the property template file you want to import.

Property template files have the .propertytemplate file extension.
5. Click Open.

The file is imported and shown in the property template list in Organizer.
If an existing template has the same name as the imported file, Organizer
adds a running number to the name of the imported file.

Organizer displays an error message if the selected file is not a valid property
template file and does not import the file.

If the imported template contains properties that are not in the list of
properties in Organizer, these properties are added as custom properties.

See also

Export a property template from Organizer (page 31)
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1.5

1.6

Export a property template from Organizer

You can export property templates from Organizer to xm1 format files and
use the exported templates in other models. You can export one or multiple
templates at a time. Exporting the templates also ensures that you have back-
up copies of the templates you have created.

For information on how to use the firm, project and system folders with
Organizer, see Customized default setup for Organizer (page 55).

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click = in the upper-right corner of Organizer to open the Settings .

3. If you want to export a specific property template, select the template
from the list of templates.

4. Click Export.

5. Select whether to export the current property template or all property
templates.

6. Click Browse to select the destination folder.

By default, the templates are exported to the \ProjectOrganizer folder
in the current model folder.

7. Click Export.

Each exported template creates a separate xm1 format file. The file extension
iS .propertytemplate.

See also
Report object property values from Organizer (page 18)

Import a property template to Organizer (page 31)

Categories in Organizer

You can categorize your model in location categories and other type of
categories that you can create based on your needs using for example object
properties.

+ Using location categories, you can create a location breakdown structure
and divide the model into projects, sites, buildings, sections and floors. A
project contains all the objects of the models that are selected in the
category properties, either the Tekla Structures model or reference models,
or both. Within a project, a model object can belong to only one lowest
level location category at a time.

Organizer always creates an uncategorized category in a project for
objects that cannot be included in any other category based on the location
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definitions you have made. You can modify the definitions to include the
objects to location categories.

* Property categories allow you to add user-defined attributes (UDA) to
model objects. Within a property category, a model object can belong to
only one lowest level category at a time.

+ Custom categories are created based on the rules that you define. Objects
are added to the categories based on these rules. You can also create
categories manually without rules.

An example of a default category set in Organizer:

Categories v
= o J5.e
~ Wl Project ()

w [ Site (-)

(7 Building (-)

[T Uncategorized (-)
» [J] Reference models (-)
v [J site ()
(D Building (-)

[T Uncategorized (-)

Property Category (-)

L ]
E-E - . . . e
4 Design Status (User Defined Attribute) (-}

| & |
4

I

Material (-)

[ &
[ o |
B Reinforcement (-)

P B Steel Material Management (-/-)
[ = | - -
&4 Cast Unit Prefix (-

» I Cast Unit Weight (-/-)
B [ayout Points (-}

When you have included objects in the categories:

+ The number of objects in a category is shown in parentheses for location
categories and property categories, and for lowest level custom categories.
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+  The number of objects in a category and the total number of objects
included in the category and its subcategories is shown in parentheses for
custom categories, as shown in the image below.

MNew Category

B COLUMN (13}
« B FOOTING (3/3)
B FOOTING (3)

B FOOTING_ 2 (2)

See also

Create location categories in Organizer (page 34)

Create location categories manually in Organizer (page 40)
Create a property category in Organizer (page 41)

Create a custom category in Organizer (page 45)

Create automated subcategories in Organizer (page 48)
Modify a category in Organizer (page 49)

Delete a category in Organizer (page 54)

Customized default setup for Organizer (page 55)
Excluding object types from Organizer (page 57)

Create location categories in Organizer

You can create location categories by defining boundary boxes for the
categories. This functionality allows you to organize model objects to sections
and floors. The objects are automatically updated to categories based on their
locations and the defined boundaries. If an object is not inside or within the
limits of a boundary box, it will be placed in an uncategorized category that is
automatically created.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select Building in the category tree.

3. Right-click and select Define boundary boxes for locations.

4. On the Building tab, define the boundary box for the building.

a. Ifthere are several grids in the model, select a grid for this building
from the Grid origin in the model list.
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The grid selection is available only if there are several grids.

The grid selection shows the global x, y and z coordinates of the grid
origins and the rotation of grids compared to the model origin
coordinates.

b. If needed, change the default name of the building.

c. Define the x, y and z coordinates for the building boundary box by
selecting the boundary coordinates from the list, or by entering
suitable coordinates in the boundary coordinate boxes.

d. Click the [ icon in front of the building to view the boundary box in
the model.

The image below shows an example of building coordinates.

Boundary boxes for locations X
Location definition for "Project > Site > Building" Unit: Millimeter (mm)
Sections  Floors Settings v

Grid origin in the model (0.0, 0,0,0,0) Rotation 0°

Building name Local X Axis Local Y Axis Local Z Axis
Building 1(0,0) - -500,0 v -5 000,0 -
6(360000) - "G(372000) ~ C+17400 (17 4C~

Modify  Close

e. Right-click in the model and select Update window to remove the
boundary box from the model view.

5. On the Sections tab, define the boundary boxes for sections.

a. Click & Section ¢4 create one or more sections.

b. If needed, change the default names of the sections.
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c. Define the x, y and z coordinates for the section boundary box by
selecting the boundary coordinates from the list, or by entering
suitable coordinates in the boundary coordinate boxes.

Ensure that the sections do not overlap and that they are inside the
building boundary box. A red exclamation mark is shown in front of
the coordinates if the boundary boxes overlap. You can save the
location definitions when the boundary boxes do not overlap.

d. Click the " icon in front of the section to view the boundary box in
the model.

The image below shows an example of section coordinates.

Boundary boxes for locations X
Location definition for "Project > Site > Building" Unit: Millimeter (mm)
Building ; Floors  Settings v
=+ Section
Section name Local X Axis Local ¥ Axis Local Z Axis
Frame 1(0,0) -500,0 -5 000,0
] x
6 (36 000,0) 30 500,0 +17400 (17 400,0)
Ramp 1(0,0) 30 500,0 -5 000,0
J »
6 (36 000,0) G (37 200,0 +17400 (17 400,0)

Modify  Close

e. Right-click in the model and select Update window to remove the
boundary box from the model view.

6. On the Floors tab, define the boundary boxes for floors.
a. Click the Floor system button.

You can add as many floor systems as you need. The added floor
systems are available in the list.

b. If needed, enter a name for the floor system.

c. Do one of the following:
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« Click \F F199r 5 add a top floor to the floor system.

You can enter the height of the top floor in the box next to the
button.

«  Click ' Floars based anarid 1o create floors automatically based on
the grid levels.

If needed, change the default names of the floors.

Define the z coordinates for the floors by selecting the boundary
coordinates from the list, or by entering suitable coordinates in the
boundary coordinate boxes.

Select a building or a section in which the floor system is used from
the list in the box at the top right.

If you have not defined sections, the buildings are shown. The
building or section is added to the box.

Floor systems can be used in several buildings and sections. If the
floor system is used in some other building and you want to remove
the floor system from that other building, you need to open the
boundary box definitions of that other building and make the
modifications there.

Click the & icon in front of the floor to view the boundary box in the
model.
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The image below shows an example of floor coordinates.

Boundary boxes for locations x
Location definition for "Project = Site = Building™ Unit: Millimeter (mm)
Building  Sections | oo | Seftings A
Floor system | Floor system | x_ | = Floar system

= Floors based on grid

Frame x
=+ Floor 0.0
Local building top
;' Floor 5 = .
= +1v3800 (13 800.0) =
Floor 4 * 1 34000

+10400 (10 400,0) *

-

Floor 3 34000 -
=1} +/200 (/0000
- -
e —
[0 | Fioor2 *| 3000 _ R
|} - +3600(36000) -
x
Floor 1 3600,0 ——————————
. +0 (0,0) hd
- -
:" Basement

Local building bottom
-

Modify  Close

—_—

h. Right-click in the model and select Update window to remove the
boundary box from the model view.

7. Onthe Settings tab, define how objects are placed in the categories.
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Organizer checks the selected options in the order in which they are
shown on the Settings tab, from top to bottom.

Boundary boxes for locations *
Location definition for "Project > Site > Building” Unit: Millimeter (mm)
Building Sections Floors etting v

Default setting for object placing

If an object is fully in a boundary box, it belongs to the

g

category of that boundary box.

Optional settings for object placing

The settings are taken into account in the order below. Place an object into the category:

W Ifit partly belongs to one category

Where the center of gravity falls

g B

based on the main part

®) based on the whole assembly

[/ If it belongs to many categories:

- Into the category that is closer to the origin according to the
order of positive x and y.

- Into the category that is closer to the building bottom in the
z direction.

¥ =

Modify  Close

The objects that cannot be included in categories based on the default
and the selected optional settings are placed in an Uncategorized
category that is created automatically on the relevant level. You can either
modify the boundary coordinates or manually move the objects to the
correct location.

Note that if you have more than one project, you cannot move objects
from one project to another.

Click Modify and Close.

Right-click any category in the project and select Synchronize category to
refresh the category content from the model.

You can also click =& to synchronize Organizer.
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When you have created the categories, the icons in front of the categories are
shown as blue in the category tree.

Wi Building
- m Section (18/18)

Floor (18)

Copy a project to property categories or custom categories

You can copy any Project from the location categories to the property
categories or custom categories.

1. Select the Project that you want to copy.

2. Drag the Project to the property categories or custom categories in the
category tree.

Organizer shows a thick line in the location to which you can copy the
Project.

3. Select the appropriate copy option:
+ Copy to copy the Project tree structure and the objects

When you copy a Project using this option and later make changes in
the Project in the location categories, the changes are automatically
shown in the copied Project.

+ Copy only the tree structure to copy the Project tree structure
NOTE If you select a Tekla Structures model in the category properties, all
assemblies, cast units, or pour units are included.

If you select any of the reference models in the category properties,
the reference assemblies or reference objects are included. If there
are no assemblies in a reference model, then the reference objects are
included.

See also

Categories in Organizer (page 32)
Modify a category in Organizer (page 49)
Delete a category in Organizer (page 54)

Create location categories manually in Organizer

You can manually create location categories without defining boundary boxes
for the categories.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
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2. Select a Project, right-click and select New site.

You can also select New project to have Organizer automatically create
Site and Building under the project.

3. Right-click the Site you created and select New building.

Right-click the Building you created and select New section or New
floor.

5. Right-click the Section you created and select New floor.

You can create as many projects, sites, buildings, sections, and floors as
you need.

6. Add objects to the categories. Do one of the following:

+ Select a category in the project to show the model objects in Object
Browser and select the objects that you want to move to the new
category. Then drag the objects to the new category.

+ In the model, select the objects that you want to move, right-click the
new category and select Move the selected objects.

NOTE You cannot move objects from one project to another. Within a
project, you can move model objects between the lowest level
categories. One object can belong to only one lowest level
location category at a time.

When you have created the categories manually, the icons in front of the
categories are shown as black in the category tree.

([ )section (16/16)
(@ Jroor (16)
(@ )section 1 (24/24)
Floor (14)
@Floor 1(10)

See also

Categories in Organizer (page 32)
Modify a category in Organizer (page 49)
Delete a category in Organizer (page 54)

Create a property category in Organizer

You can create property categories to add properties to model objects. You
can use existing user-defined attributes (UDAs) in the categories and add
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values to them, or you can create UDAs as custom properties in Organizer
and use these in the property categories.

NOTE If you have several property categories, you can use a certain UDA in
only one root level property category. This ensures that other
categories do not overwrite the UDA.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. In Categories, select a property category at the root category level, right-

click and select Properties.

—
- ‘

v W) Project (2744)
[l Uncategorized (59)
~ [ Site (2685)

P []] Building (2685)

b B Reinforcement (4825

» 11 Object (399/399)

g

Mo highlight or selectio

Move the selected objects

Remove the selected obje

MNew category

New subcategory

Create automated subcate

Select in the model

Rename

Properties k

Synchronize the category.

Add content to the category (page 45).

Properties are added to the objects that are in the category. You can add
the category content manually (page 49) by selecting objects in the
model and inserting them to the category, or by defining rules that
automatically insert objects to the category.

You can also add subcategories (page 48) to the category. Subcategories
can be added manually or automatically based on a property. The
property values are written to objects from lowest level categories.
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Select the Do not delete empty automated subcategories check box to
keep all subcategories at synchronization. If you do not select the check
box and change the model so that some, or all of the subcategories do
not contain any objects, the empty subcategories are deleted when you
synchronize the root category or the whole Organizer.

Select the Include the highest assembly level in the model option if
you want to ensure that only highest level assembly objects are inserted
to the category.

4. Under Object properties, select a custom property or an existing UDA.
You can add more than one property.
5. Define the property settings:
¥ Object properties
Property Type Value Unit
|_Te><t - x
a. Select the value type from the Type list and define the value in the
Value box.
The type determines what kind of values you can use.
Typ Type Value
e of
UDA
Strin | Text Enter text or a number.
2 Category name Organizer adds the name of the category to the
Value box automatically.
Combined category  Organizer adds the names of the categories to
names the Value box automatically.
Inte | Number without Enter a number.
ger |decimals
Dou | Number with Enter a number with decimals.
ble |decimals
Formula Select a formula from the Value list. Formulas
are defined in Organizer Settings.
Date | Date Enter a date or select it from the calendar.
b. Select a unit for the value from the Unit list.

Only the possible unit options are available for the property:

* The units of the properties are defined in
contentattributes userdefined.lst Or object.inp files.

Organizer
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+ The units of custom properties that are created in Organizer are
defined when creating the property.

c. Modify the properties in the subcategories if you want the
subcategories to have different property values for the same

property.
+ If you want a property to use the property value defined on the

higher property category level, select the Inherit value check box
after the property name.

+ If you have selected the Inherit value check box but select a type
in the Type box or enter a value in the Value box, the Inherit
value check box is cleared automatically.

NOTE The property values are written to the objects from the
lowest level subcategories.

When you write the custom properties you have created in
Organizer to the model, you can use these properties as any
other UDAs in the model.

When the properties are written to the model, you can use them in
visualization and IFC export, for example. You can also view the
properties in object dialog boxes and share them with Tekla Model
Sharing.

6. Clear the Update category at synchronization check box if you do not
want to update the category when you synchronize the whole Organizer
with the model.

7. Click Modify.

Organizer creates an Uncategorized category for the objects that are not
included to the lowest level categories yet. If the same objects would
belong to more than one subcategory based on the category rules,
Organizer creates a Clashing category for these objects. You need to
modify the category rules to empty the Clashing category.

8. Click & to synchronize Organizer, or select any category in the property
category tree, right-click and select Synchronize category.

Properties and their values are written to the model objects when
Organizer or the category is synchronized. Uncategorized and Clashing
categories do not modify the existing UDA values.

You can inquire the properties written to the model and report them as
any other properties.

NOTE If you delete a property category and its subcategories, the properties that
have already been written to the model are not removed.
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UDAs with options

If you add UDAs with options to a property category when writing properties
to the objects, you have to use the UDA - <property name> format.

To get the correct report result in Object Browser, you can use the same
property without UDA - in the name.

oM - o x
v v
= . X =3 = + O
ber  Prefile | Length / mm  Weight /t Phase Area (Gross)/ m2 | UDA - LOAD_BEARING LOAD_BEARING USERDEFINED.LOAD_BEARING  » @ Pour status
HEALD 6910 0.862 1321 0 Ne ® Bearing (- |
® No
Category Properties X ® Share (-

for setting category content

object content
Automated subcategories

Value

Number without decimal: Bearing ' x

plate: | SteelProfilelnfo ~

Delete Category ify  Close

See also
Categories in Organizer (page 32)

Example: Organizer for precast (page 121)

Create a custom category in Organizer

You can create custom categories to group model objects, for example, based
on object properties.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Click * to create a new category.

If you have a category selected, the new category is created on the same
level as the selected category. If you have several categories selected or
do not have any category selected, the new category is created at the root
category level. You can add as many categories as you need.

3. Right-click the new category and select Properties.
4. Type a name for the category.
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5. Define the rules for setting the category content:

a.

b.

Under Automated object content, select the models, filters and
categories that are used to automatically add objects to the category.
Do any of the following:

Click the Select model list and select a model to add its objects to
the category.

To include all model objects in the category, select the Tekla
Structures model.

Drag a category from the category tree to the categories and
filters rule box, or click or type in the box and select a filter from
the list.

Click Object group to define a filter for Organizer.

The Object Group - Organizer dialog box opens in the Tekla
Structures main view. When you have saved the filter, click or type
in the rule box again and select the filter.

Organizer filters are saved in the \attributes folder of the
model folder with the .0rgObjGrp file extension. You can use
these filters only in Organizer.

You can add as many filters and categories as you want to the same
rule box.

If you add more than one category or filter to the same rule box, the
category content is a union of all the objects in them.

If you add categories or filters to separate rule boxes, select whether
the category content is an intersection or difference of the content of
the boxes.

NOTE You can also separately create filters for Organizer before

creating any categories. These filters are created in the same
way as Tekla Structures selection and view filters, and you can
use them in category rules. When creating the filters, click

|L| in the filter settings and set Organizer as the filter type.
Then define the settings needed in the filter.

Under Automated subcategories, select the properties that are
used to create the subcategories. Do the following:

Click Grouping in Object Browser.

To use this option, drag one or more property columns to the
grouping (page 13) row in Object Browser. Organizer uses the
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TIP

properties included in the columns when creating the
subcategories.

You can also add property template columns or object properties
to the rule boxes.

+ Click the rule boxes and select a property template column or an
object property.

Note that you cannot use the Grouping in Object Browser option
if you first add property template columns or object properties to
the rule boxes.

You can add more than one column or property to the same rule
box.

Organizer adds a new subcategory level to the properties dialog
box when you have added a column or a property to the rule box.
If you want the category to have the new subcategory level, add
columns or properties to the rule boxes on the new subcategory
level.

+ Select the Do not delete empty automated subcategories check
box to keep all subcategories at synchronization.

If you do not select the check box and change the model so that
some, or all of the subcategories do not contain any objects, the
empty subcategories are deleted when you synchronize the root
category or the whole Organizer.

c. Select the Include the highest assembly level in the model option
if you want to ensure that you have only assembly level objects in the
category.

When you select this option and add a model object to the category,
the assembly to which the object belongs will be added to the
category.

Clear the Update category at synchronization check box if you do not
want to update the category when you synchronize Organizer with the
model.

Select a default property template for the category from the Property
template list.

This is the property template that is shown in the Object Browser
property table.

Click Modify.

You can manually add categories and subcategories to automated categories.
Select a category, right-click and select New category or New subcategory.
Manually added categories are not deleted at synchronization. When you
synchronize a manually created subcategory, only that category is synchronized.
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See also

Customized default setup for Organizer (page 55)
Categories in Organizer (page 32)

Modify a category in Organizer (page 49)

Delete a category in Organizer (page 54)

Create automated subcategories in Organizer

You can create an automated subcategory tree structure for one or several
custom categories at a time. The categories for which you create the
automated subcategories cannot already have subcategories. If you use an
empty category that does not contain objects yet, only the category rules are
saved.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Select a custom category, right-click and select Create automated
subcategories.

Organizer opens the Automated subcategories section in the category
properties dialog box.

3. Do the following to select the properties that are used to create the
subcategories:

+ Click Grouping in Object Browser.

To use this option, drag one or more property columns to the grouping
(page 13) row in Object Browser. Organizer uses the properties
included in the column when creating the subcategories, for example,
as shown in the image below.

Y Automated subcategories

Grouping in Object Browser

Object properties used to create automated subcategories under "Custom Category™

Create subcategories based on: »

INAME X | OR |ASSEMBLY_NAME X OR |CAST_UNIT_NAME |

OR |BOLTNAME X | OR |NUT.NAME X | OR |MAINPART.NAME X |

You can also add property template columns or object properties to
the rule boxes.

Organizer 48 Categories in Organizer



TIP

+ Click the rule boxes and select a property template column or an
object property.

Note that you cannot use the Grouping in Object Browser option if
you first add property template columns or object properties to the
rule boxes.

You can also type the name of the property in the box, for example,
PROFILE and press Enter. You can add more than one column or
property to the same rule box.

Organizer adds a new subcategory level to the properties dialog box
when you have added a column or a property to the rule box.

If you want the category to have the new subcategory level, add columns
or properties to the rule boxes on the new subcategory level.

Select the Do not delete empty automated subcategories check box to
keep all subcategories at synchronization.

If you do not select the check box and change the model so that some, or
all of the subcategories do not contain any objects, the empty
subcategories are deleted when you synchronize the root category or the
whole Organizer.

Click Modify.

You can manually add categories and subcategories to automated categories.
Select a category, right-click and select New category or New subcategory.
Manually added categories are not deleted at synchronization. When you
synchronize a manually created subcategory, only that category is synchronized.

See also

Categories in Organizer (page 32)

Create a custom category in Organizer (page 45)

Modify a category in Organizer (page 49)

Delete a category in Organizer (page 54)

Modify a category in Organizer

You can modify the category rules and make manual changes to the category
content.

1.
2.

To open Organizer, click Manage on the ribbon and then click Organizer.
Do any of the following:

To Do this

Rename a category Select a category, right-click and select Rename.
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To

Do this

Add objects to a
category

You can manually add objects to a category.

1. Select objects in the model or select a category.

2. Select objects in Object Browser by selecting rows.
3. Drag the selected objects to a category.

If you want to add all the objects that you have selected
in the model, you can also right-click the category and
select Add the selected objects.

CIickﬁR 'to hold the view in Object Browser. When you
hold the view, you can make selections in the model or in
the categories without changing the contents shown in
Object Browser. To show objects per category in Object

L = u .
Browser, click = and select . ® Separate categories.

In location categories, when you select objects in one
category and add them to another category, the objects
are moved to the other category. An object can be in only
one lowest level location category within a project.

Remove objects from
a category

You can manually remove objects from a category.
1. Select a category.
2. Select the objects in Object Browser.

3. Right-click and select Remove the selected objects
from the selected categories.

Manage manual
changes in a category

Organizer

You can view in Object Browser how each object has
been included in the category, or why it is not included.
Objects can be included in categories either automatically
based on category rules, or you can add and remove
them manually.

1. Select a custom category.

2. Right-click the category and select Properties to view
the rules used in the category.

The properties show whether there are manually
added and removed objects in the category. You can
control the status of the objects in Object Browser.

Click = and select ™ Manage manual changes.

Organizer places a purple frame around Object
Browser and Categories, and adds a Status column
to Object Browser. In the manual change mode, a
limited set of Organizer commands is available.

Each object has a status icon:
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To

Do this

T

The object has been automatically added to the
category based on the category rules.

©
The object has been automatically added and
manually removed from the category.

The object has been automatically added to the
category and manually added to the category.

T
|\t]

The object has been manually added to the
category.

The object has been manually removed from the
category.

Note that the status applies in the selected category.
The object may have a different status in another
category.

Right-click an object in Object Browser to change
the status:

Add manually adds the object to the category.

Remove manually removes the object from the
category.

Remove manual changes removes manual
status from an object but leaves the object to the
category if it has been included automatically.

Modify category rules

Organizer

Select a category, right-click and select Properties.

Modify the category content rules under Automated
object content .

The ‘¥ icon in the Automated object content
button shows that the category has automated
object content rules defined.

Do any of the following:

Select a model from the list of models.

Click Model list to see which models are already
used in the rules.
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To

Do this

4.

+ Drag a category from the category tree to the rule
box.

+ Click or type in the rule box and select a filter
from the list.

+ Click Object Group to define a filter for
Organizer. When you have saved the filter, click
or type in the box again, and select the filter.

You can add more than one category and filter,
and create unions, intersections, or differences of
them.

Modify the subcategory rules under Automated
subcategories.

The ‘¥ icon in the Automated subcategories
button shows that the category has automated
subcategory rules defined.

Do any of the following:

+ Click the rule boxes to add more property
template columns or properties to the rules.

You can add more properties to the existing
subcategory hierarchy levels or to the empty
hierarchy level that is under the existing levels.

* Remove a property from the rules.

*  Remove a whole subcategory hierarchy level from
the rules.

Click Modify.

You can modify the subcategory rules of several
subcategories at the same time if they have the same
subcategory rules, see also Create automated
subcategories in Organizer (page 48).

Change the default
property template of a

1.

Select a category, right-click and select Properties.

category 2. fslﬁgclgsé)'lcii;ir property template from the Property
3. Click Modify.

Modify the properties | 1. Select the categories you want to modify.

of multiple categories 2. Right-click and select Properties.

The properties you can modify depend on the selected
categories. You can, for example, change the default
property template or subcategory rules.

Organizer
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To

Do this

Change the category
content to include the
highest assembly level

Select a category, right-click and select Properties.

Select the Include the highest assembly level in
the model check box.

3. Click Modify.

If you add parts to a category that includes only
assemblies, the assembly information is shown in the
category.

Modify the boundary
boxes of a building,
section or floor
category

1. Select a category that you have created using
boundary boxes.

2. Right-click and select Define boundary boxes for
locations.

3. Modify the boundary box definitions.

If you modify a building coordinate and a section has
the same coordinate, the section coordinate changes
to the modified building coordinate.

The categories you have created using boundary boxes
have a blue icon in the category tree.

Add a floor manually
to a building that has
an automated location
breakdown structure

You can manually add floors to automated buildings, for
example, to collect the objects of special structures within
a building into separate categories. The manually added
floors do not have a boundary box for automated object
collection. You can add objects from any part of the
building.

You can use the manual floor category, for example, to
separate the elevator shaft from the rest of the building.

1. Select a section under a building that has an
automated location breakdown structure.

Right-click and select New floor.
Add objects to the floor.

Select the Project root category, right-click and select
Write to the model for reporting to write the new
location information to the model objects.

Add a category
manually to an
automated category

You can manually add categories to automated
categories. Manually added categories are not deleted at
synchronization even if they do not contain any objects.

1. Select an automated category.

2. Right-click and select either New category or New
subcategory.

Organizer
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To Do this

Copy or move a You can copy or move one category and its subcategories
category at a time.

1. Select a category and drag it to a suitable location in
the category tree, either on top of a category or
between two categories.

2. Select a suitable option from the list:

+ Copy copies the category properties and the
objects in the categories to the target category.

+ Copy only the tree structure copies the tree
structure without the objects and their
properties.

+ Move moves the category with the objects and
their properties to the new location.

See also
Synchronize Organizer with the model (page 57)
Categories in Organizer (page 32)

Delete a category in Organizer

You can delete categories in Organizer. Note that there must be at least one
location category, one property category and one custom category in the
Organizer category tree. You cannot delete the last categories.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select a category.

You can select more than one category.
3. Right-click and select Delete.

If you have used the selected category in the property rules of other
categories, Organizer shows a dialog box where these categories are
listed.

4. Click Yes to delete.

NOTE To permanently delete a subcategory from a category created with the Create
automated subcategories command, you must remove the subcategory
objects from the main category. If you do not remove the objects from the
main category, the subcategory will be created again based on the main
category rules when you synchronize Organizer.
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See also
Categories in Organizer (page 32)

Customized default setup for Organizer

You can customize Organizer by creating a setup that opens the same
templates and categories in all new models. A customized setup is useful if
you have templates and categories you want to use in all models. Then you do
not need to create or import the templates and categories for each model
separately. The customized setup is used when you open Organizer in a
model for the first time.

You can also exclude some object types (page 57) from Organizer using the
ExcludedTypesFromOrganizer.xaml file. Excluded object types are not
displayed in Object Browser and they are not included in categories.

To make the customized property templates and categories available in all
models, store the templates in the \ProjectOrganizerData
\PropertyTemplates folder and the categories in the
\ProjectOrganizerData\DefaultCategoryTrees folder. The templates
and categories are stored as in the xm1 format. Property template files have
the .propertytemplate file extension and categories have the .category
file extension.

NOTE The defined location categories are automatically imported but they behave
like manually created categories. Automatic categories need to be defined in
each model separately.

You can have the folders under any or all of the following folders:
+  Current model folder

* Project folder, defined in the xs PROJECT advanced option

+ Firm folder, defined in the XS FIRM advanced option

+ Folders defined in the xs _sySTEM advanced option

Example of folders:

ProjectCrganizerData
| DefaultCategoryTrees
PropertyTermnplates

= ExcludedTypesFromOrganizerxaml .

All templates and categories in these folders are loaded to Organizer when
you open it for the first time in a model. If there are many files with the same
file name in several different folders, the first file found is loaded and the
other files with the same file name are ignored. The search order is always:
model, project, firm, system. The roles.ini does not affect this order.
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For example, if you have rebar.category, category.category and
material.category in a system folder \ProjectOrganizerData
\DefaultCategoryTrees folder, these files will all be l[oaded automatically to
the categories. If you also have a rebar.category file in the \PROJECT
\ProjectOrganizerData\DefaultCategoryTrees folder and in the
\model\ProjectOrganizerData\DefaultCategoryTrees folder, only the
first rebar.category file found is used. In this case, the file under the model
folder would be the first one found.

NOTE You can use the roles. ini files to control multiple setups. For example,
create a \Concrete\ProjectOrganizerData folder and a \Steel
\ProjectOrganizerData folder under the firm folder. Then define in the
roles.ini file which of these folders is read and/or in which order the
folders are read. This way you can read only the \Concrete folder files, or
read the \Concrete folder first. In this case, the files with the same name in
the steel folder are ignored.

The loaded templates and categories are saved in the ProjOrg.db in the
\ProjectOrganizer folder under the model folder. When you open
Organizer for the first time, the ProjOrg.db is created and the files are read
in from the model, project, firm and system folders. The Projorg.db
database stores all template and category information used in the model.
When you make changes to the templates and categories in the folders, they
are not automatically updated in ProjoOrg.db. The database will not read in
the template and category xm1 files again, so updates to the files will not be
automatically applied.

If you want to apply the changed templates and categories to the Projorg
database, you have two options:

+ Delete the old templates and categories in Organizer and import the
changed templates and categories. We recommend that you use this
option.

+ Export from Organizer all the templates and categories that you want to
keep and close the model. Delete the ProjoOrg.db database from the
\ProjectOrganizer folder under the model folder, and re-open the
model. Import the exported templates and categories back to Organizer.

NOTE The second option will reset Organizer completely. All data will be
lost if not exported.

See also

Categories in Organizer (page 32)

Import a category to Organizer (page 63)

Import a property template to Organizer (page 31)

Export a category from Organizer (page 61)
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1.7

Export a property template from Organizer (page 31)

Excluding object types from Organizer

Some object types can be excluded from Organizer. These object types are
listed in the ExcludedTypesFromOrganizer.xaml file thatis by default
located in the \system\ProjectOrganizerData folder in the Common
environment. The location may vary depending on your environment.
Excluded object types are not displayed in Object Browser and they are not
included in categories, even if you select in the category rules to include a
model and all its objects to a category. For example, loads, cuts and fittings are
listed in the ExcludedTypesFromOrganizer.xaml file and excluded from
Organizer.

You can modify the ExcludedTypesFromOrganizer.xaml file to either
include or exclude the object types. Before you modify the file, we recommend
that you copy it to the \ProjectOrganizerData folder that is under the
model folder. You may need to create the \ProjectOrganizerData folder as
it does not by default exist in the model folder.

For example, to exclude fittings, change the value as follows:
<Fitting>true</Fitting>1t0o<Fitting>false</Fitting>

To include fittings again, change the value false back to true.

To apply the changes, click Sin Categories to fully synchronize Organizer
with the model.

NOTE Do not add or remove any lines from the
ExcludedTypesFromOrganizer.xaml file, otherwise Organizer will not be
able to use the file.

You can also customize Organizer by creating a setup (page 55) that opens the
same templates and categories in all new models. A customized setup is useful
if you have templates and categories you want to use in all models.

Synchronize Organizer with the model

You can synchronize Organizer with the model to ensure that the categories
are up to date and that Object Browser shows the latest object property
values from the model. You can also synchronize individual categories or
reload the Object Browser view.

Synchronization adds location information (page 60) to model object
properties. You can use the location information when creating reports and
inquiries.
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Synchronize Organizer

Synchronizing Organizer < updates all properties of the changed objects in
the Organizer database. You do not need to reload Object Browser if you
change the selection in the model, or select another category or property
template. When you have synchronized Organizer, the object properties are
up to date until you make changes in the model.

Organizer is synchronized:

*  When you click < Synchronize with the model..
*  When you open Organizer and select to synchronize it.

To make synchronization faster, set the XS COLLECT MODEL HISTORY
advanced option to TRUE. If XS COLLECT MODEL HISTORY is set to FALSE, at
synchronization all objects are loaded to check what has been deleted in the
model.

When you synchronize Organizer, the Tekla Structures action history that is
used in undoing the last action is deleted. This means that you cannot use the

Undo (Ctrl +2) 2 command immediately after you have synchronized.
Otherwise, Undo works normally.

Note that the Undo history list O is cleared when you synchronize
Organizer. The Undo history list shows all the commands that you have run
and the modifications that you have made in the model. Saving the model also
clears the list.

You can define in Organizer Settings = that Organizer is always
synchronized when you open it. Go to the Synchronization tab and select the
Always synchronize Organizer with the model when opening. check box.

When you open Organizer and select the Do not show this dialog again.
check box in the Synchronize dialog box, Organizer does not show the
Synchronize dialog box anymore in any model where you use Organizer. To
get the Synchronize dialog box back, browse to the \users\<user>
\AppData\Local\Trimble Solutions Corpora folder and delete all the
files starting with ObjectBrowser. Note that deleting these files deletes the
default Organizer unit settings. Check the unit settings in Organizer Settings.

Update the whole Organizer database

You can update the whole Organizer database so that the properties you have
viewed in Object Browser, or that are used in categories, are updated to all
model objects in the Organizer database.
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The Organizer database is updated:

*  When you press Ctrl + < Synchronize with the model.

*  When you open a model that was saved with an older Tekla Structures

version and click Q,Synchronize with the model.

*  When you change the value of the XS ENABLE POUR MANAGEMENT
advanced option and open Organizer. The cast-in-place object hierarchy is
replaced with pour unit hierarchy.

*  When you change any model-specific advanced option and the next time
click Q,Synchronize with the model.

*  When you save the model with Save as and the next time click <

Synchronize with the model.

*  When you change the material catalog and the next time click <
Synchronize with the model.

Reload Object Browser

Click the & reload button in Object Browser when you want to view the
latest property values from the model. Once you have viewed a property of
any object in Organizer, the property will be updated in the Organizer
database at synchronization.

If you make changes in the model while viewing the objects, reload Object
Browser.

NOTE When you select objects in the model or in the categories, Object Browser
shows the properties that are already in the Organizer database, and loads
the new values from the model to the properties that are not yet in the
Organizer database.

You have to Reload the view & in Object Browser to update the view with
the new values.

Synchronize a category

Organizer is partially synchronized:

*  When you select a category, right-click and select Synchronize category.
To view the synchronization date and time, right-click the category again.

*  When you synchronize categories at export.

Partial synchronization:
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+ Synchronizes the whole project when you synchronize any location
category, such as a Floor.

* Synchronizes the categories that are used in the category rules of other
categories when you synchronize these other categories.

+ Synchronizes the whole category tree created by automated subcategory
rules when you synchronize one subcategory in the tree.

+ Synchronizes the whole category tree when you synchronize a manually
created subcategory in a property category tree.

NOTE Partial synchronization does not update the properties shown in Object

Browser. You need to reload & Object Browser to show the updated
category content.

Exclude a category from synchronization
1. Select a category, right-click and select Properties.
2. Clear the Update category at synchronization check box.

The objects that are deleted from the model are removed from the category
even if the Update category at synchronization option is not selected.

Report Organizer location categories

You can use location category properties in reports. If you have more than one
project in a model, you need to select which project, including the
subcategories in the project, is used in reporting. You can use only one project
at a time. When you synchronize a project, the report properties are always
written to the model.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select a Project.
3. Right-click and select Use for reporting.
The icon in front of the Project that is selected for reporting is shown as
black M,

4. Right-click the Project again and select Write to the model for
reporting.

The report properties are updated to the model.

The location properties of the assembly level objects in the model are:
* LBS PROJECT

* LBS BUILDING

* LBS_SECTION
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* LBS_SITE

* LBS_FLOOR

* LBS FLOOR ELEVATION

* LBS_HIERARCHY LEVEL NUMBER
* LBS_HIERARCHY

5. To change the project used for reporting, select another Project, right-
click and select Use for reporting.

6. Right-click the Project again, and select Write to the model for
reporting.

The report properties are updated to the model.

NOTE When using location properties in a report template, you need to add
LOCATION BREAKDOWN STRUCTURE to the property name, for example,
LOCATION BREAKDOWN STRUCTURE.LBS FLOOR.

See also
Categories in Organizer (page 32)
Synchronize Organizer with the model (page 57)

Export a category from Organizer

You can export categories from Organizer to an xm1 format file and use the
exported categories in other models. You can export the selected categories,
or all location categories, custom categories, and property categories at a time.
Organizer creates only one . category export file even if you export more
than one category at a time. By exporting categories you can ensure that you
have back-up copies of the categories you have created.

For information on how to use the firm, project and system folders with
Organizer, see Customized default setup for Organizer (page 55).

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select one or more categories.

3. Click # and select Export Organizer categories.
Define the export settings.

a. Select All categories or Selected categories with their
subcategories.

+ Exporting location categories: The whole project is exported even
if you only select a subcategory in the project, for example, a floor.
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Exporting categories that have been created using rules: The
whole category tree is exported. If you select a subcategory, the
main category and the other subcategories in the category tree
are also exported.

Exporting property categories: The whole category tree is
exported. If you select a subcategory, the main category and the
other subcategories in the category tree are also exported.

Exporting categories that have been created manually: Only the
selected category is exported.

Select the Include the properties of the categories check box to
include category properties in the export.

If the rules in category properties include a filter, and you plan to
use the category in another model, the filter must be available in
that model. Otherwise, the category will not have the correct
content.

If you do not select Include the properties of the categories,
only the category name is exported. The property template is set
to the default template in the export.

Select the Include the objects check box to include the object GUIDs
in the export.

If the exported category is used in other models, the categories will
be empty.

Select the Synchronize the categories before export check box if
you want to ensure that the latest model changes are included in the
export.

Click Browse to select the destination folder.

By default, the category is exported to the \ProjectOrganizer folderin
the current model folder.

Click Export.

If the category you are exporting includes other categories in the category
property rules, and you have not selected these other categories to the
export, the Export category structure references dialog box is
displayed.

a.

Export the valid references exports categories including the rules
defined in the category.

This option is dimmed when you have not selected the categories
defined in the rules for export. Click Cancel and select the category to
export and the categories used in the rules. When you do this, the
Export category structure references dialog box is not shown at all.
In import, all exported categories will now be imported.

Organizer 62 Export a category from Organizer



1.10

7.

Export without references exports the object GUIDs in the
categories if you have selected the Include the objects check box in
the Export category structure dialog box.

If you have not selected to include the objects, only the category
name is exported. In import, Organizer treats this category as a
manually created category.

Click OK.

See also

Import a category to Organizer (page 63)

Categories in Organizer (page 32)

Import a category to Organizer

You can import categories that have been exported from Organizer in the
current model or in other Tekla Structures models. The category import files
are in the xm1 format, and have the . category file extension. You can import
one .category file at a time. The file can contain many categories.

For information on how to use the firm, project and system folders with
Organizer, see Customized default setup for Organizer (page 55).

1.

o vk~ W N

To open Organizer, click Manage on the ribbon and then click Organizer.

Click # and select Import Organizer categories.

Click Browse.

Select the . category file you want to import.
Click Open.
Click Import.

If the category you are importing has the same name as an existing
category, you have the following options:

You can import the category and replace the existing category.
You can select not to import the category.

You can import the category but keep the existing category. If you
import a category that has the same name as an existing category,
Organizer adds a running number to the category name.
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Location categories are added at the end of the location categories, property
categories at the end of property categories, and custom categories at the end
of the custom categories.

NOTE If the imported category does not contain any objects, check if the
rules in the category properties have a filter that does not exist in the
model. When you add the filter to the model, the category content is
updated. Another reason could be that there are no objects in the
model that match the rules.

The category may also be empty if it has only manually added content
and the objects were not included in the export. If you have imported
the category from another model, the manually added content is not
imported.

See also
Categories created in earlier Tekla Structures versions (page 64)
Export a category from Organizer (page 61)

Categories in Organizer (page 32)

Categories created in earlier Tekla Structures versions

If you have used the Model Organizer tool in the same model in an earlier
Tekla Structures version, the categories created in Model Organizer are
automatically transferred to Organizer. Model Organizer categories are
shown in the custom categories in Organizer.

When you are using Organizer in a model created in an earlier Tekla
Structures version:

+ If you have never opened Model Organizer in the earlier Tekla Structures
version model, no categories are imported.

+ If you have opened and closed Model Organizer in the earlier Tekla
Structures version model, the project and site logical area categories are
imported to Organizer.

+ If you have added at least one object to the Model Organizer logical area
categories, the logical area categories are imported to Organizer.

+ If you have added at least one object to the Model Organizer object type
categories, all the categories are imported to Organizer.

Model Organizer property sets are imported to Organizer, converted to
property templates, and named after the categories. If several categories have
the same name, a running number is added to the property template name.

See also
Import a category to Organizer (page 63)
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Categories in Organizer (page 32)

Import IFC categories to Organizer

You can import the location breakdown structure of an IFC model as IFC
categories to the location categories in Organizer.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Select a Project, right-click and select New IFC project.

3. Select the IFC model.

4. Click Import.

The IFC categories are imported at the bottom of location categories. The
objects of the imported IFC model are automatically included in the IFC
categories.

5. Ifthe IFC model is changed, you can update the latest version of the
model to the categories. Select the highest IFC category level in the
category tree, right-click and select Update.

TIP If you import IFC categories that have the same name as existing IFC categories,
Organizer adds a running number to the category name. You can rename the
categories.

See also

Categories in Organizer (page 32)

Organizer in the multi-user mode

When using Organizer in the multi-user mode, only one user at a time can
save changes. The first user who opens Organizer becomes the main user and
is the only user who can save changes. When the main user closes Organizer
and saves the model, another user who wants to save changes must first close
Organizer and open it again to be able to save changes.

If there already is a main user in Organizer when another user opens
Organizer, the other user will get a message that the database is locked and
that changes cannot be saved permanently. Note that even though only one
user at a time can save changes, other users can still select, create and modify
categories and property templates. Other users can export the categories and
property templates they have changed, and import them back to Organizer
for saving.

NOTE Organizer data is not shared in Tekla Model Sharing.
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See also
Organizer (page 5)

Example: Organize the model into location and
custom categories, and view quantities

This example will go through the basic workflow of setting up Organizer, and
creating concrete and reinforcing bar take-offs.

You will use Organizer to organize your model into buildings, sections and
floors based on the locations in the model. You will create a category tree
structure and custom categories. When you have created the locations and
custom categories, it is fast and easy to view and report quantities in Object
Browser.

In the example, the set-up is done using the Cast in Place Sample model
that is available in the Default environment as a model template. You can
delete the existing set-up or just create a new project and start setting that up.

Example: Organize the model to buildings, sections and
floors

You will now organize your model to location categories (page 34).

1. To open Organizer, click Manage on the ribbon and then click Organizer.
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Select the Building category under Project, right-click and select Define

boundary boxes for locations.

Adjust the boundary box for the building by selecting or entering

coordinates.
Boundary boxes for locations

Location definition for "Project > Site > Building”

x

Unit: Millimeter (mm)

Sections Floors Settings v
Grid origin in the model (0,0, 0,0,00) Rotation 0°
Building name Local X Axis Local Y Axis Local Z Axis
Building 1(0.0) - -500,0 - -5 000,0 -
6(360000) « "G(372000) + C+17400 (17 4C~

Modify  Close

Go to the Sections tab and add two sections to your building using the

values shown in the image below.
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Boundary boxes for locations X

Location definition for "Project > Site > Building" Unit: Millimeter (mm)
Building Sections | | Floors Settings v
<+ Section
Section name Local X Axis Local Y Axis Local Z Axis
_ frame 100 -500,0 -5000,0
N ] x
6 (36 000,0) 30 500,0 +17400 (17 400,0)
5 Ramp 1(0,0) 30 500,0 -5.000,0
o
6 (36 000,0) G (37 200,0) +17400 (17 400,0)

Modify  Close

——

You can click the blue box in front of the section name to visualize the
section in the model. The image below shows the Frame section.

Boundary bowes 1o I0cations x
Lecation gefinitien for “Project > Site > Building™ una: Millimeter (mm)
Buiding <ot foos  Settings v
= Section
Section name Locai X Ais Local ¥ Axis Local Z Axis
o Fame 100 5000 50000
] =
6 (36,0000 305000 +17400 (17 4000)
p Ramg 1 0 30 5000 £ 0000
a =
6 (36,0000 6 (37 2000) +17400 (17 4000
Modity  Close

Go to the Floors tab and create a floor system for the Frame section
based on the grid lines.
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Boundary boxes for locations x

Location definition for "Project = Site > Building” Unit: Millimeter (mm)
Building | Sections | Fiocs ¢ Settings A
Floor system .F!DDI system | x_ | =+ Floor system
=+ Floors based on grid
. Frame X
S Fioor, 0.0
Local building top
il
T N 4
_.J Floor 5 —
—_ +13800 (13 800,0) =
-
:| Floor 4 ® 34000

“+10400 (10 400,0) ¥

14

| [

(L} | Fioor3 34000

== . 7200 (70000~
e [hyem

[0 | Ficor2 *| za00 ______
| - +3_§UO (36000) «
_________________________________________________[g=m

Y

Floor 1 Is0OO

i) | Ficor . +0 [0.0) d
A Basement Local building battem

Click Modify and Close.

You have now organized the model to sections and floors based on
locations.

There are three ramp objects that are located in the Basement of the
Frame section. You have to move these manually to the Ramp section:

a. Select the Basement category, right-click and select Select in the
model to view the objects in the model.

b. Select the three ramp objects in the model.
c. Right-click the Ramp category and select Move the selected objects.
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Example: Create a custom category with automated
subcategories based on object names in Organizer

You will now create a custom category (page 45) for assemblies, and divide the
category to subcategories based on the assembly name.
1. Click * to create a new custom category.

2. Right-click the Custom Category and select Properties. Rename the
category as Object.

3. Under Automated object content, add the material filters Material -
Concrete and Material - Steel to the rules. You can also select the
Tekla Structures model to include the Tekla Structures objects in the
category content.

Category Properties

Name: ‘Object

=» Object

- Rules for setting category content

Y Automated object content

Select the model to automatically add objects to this category Model list

|Tekla Structures mode| *

| -

)

Add categories or filters to automatically add objects to this category. YObject group...

|7 Material - Concrete % | ‘ |T Material - Steel x
| v

4. Click Modify to add the objects to the category.

5.  Next, group the objects in Object Browser. Click *=. and select Group to
create a grouping based on the Name column. The grouping you see in
Object Browser is a preview of the automated subcategories.
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9.

& Organizer

NSE A4
& £ oetou “ | moary [ = b L3 as
Name & X
Contentty & Material type Material Position number | Profile Top level f mm | Height / mm  Length / mm | Width / mm
b ANCHOR BOLT (121)
6236
» BEAM (114)
1139 680
PN COLUMN (190)
648 400
» ELEVATED SLAB (10)
280 000 200
PN EMBED (406)
81 694
» FASTENER (288)
14 400 5C
b N FOOTING (46)
315 896
» GROUND SLAB (14)
189 294
» PAD FOOTING (38)
19 000
» STAIR (6)
19 200 3200
b STAIRCASE SLAB (34)
109 610
» STAIRCASE WALL (50)
112 500 15¢
Number of objects in the table: 1449 Result of:| Total ~ | Of these rows:| al -

3714707

Now create automated subcategories for the category based on object
names. Right-click the new category, select Properties and under
Automated subcategories, click Grouping in Object Browser. This adds
the object properties that are used in the grouping to the category
properties.

Select the Include the highest assembly level in the model check box.

Selecting Include the highest assembly level in the model ensures that
only assemblies and cast units are included in the category. Otherwise,
the category will include both parts and assemblies. Using assemblies in
categories is important because later you will select and view multiple
different categories, and this will require using hierarchical dependencies
for objects. Also, Organizer is built to work with assemblies.

Select the Default property template for Object Browser.
Click Modify.

The subcategories are created under the Object category. If you now make
changes to the model, the category and the subcategories will be updated. For
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example, new subcategories are created and old ones deleted based on the
names found in the model.

|

:j ANCHOR BOLT (64)
11 Assembly (9)

I seam (94

11 coLumn (93)

13 ELEVATED SLAB (5)
11 eMBED (183)

I] FASTENER (90)

11 FooTING (43)

Il GROUND SLAB (7)
13 STAIRCASE SLAB (17)
13 STAIRCASE WALL (25)
11 staRs (5)

1 waLL (50

Next, you will create a custom category for reinforcing bars.

Example: Create a custom category for reinforcing bars in
Organizer

You will now create a custom category (page 45) for reinforcing bars.

1. Create a new category and name it Reinforcement. Select to use the
Object type - Reinforcement filter in the category property rules.
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If you do not have a filter for reinforcement, click Object group and create
a filter as shown in the image below.

& Object Group - Organizer @
Save/Load

Object type - Reinforcement v |Save Object type - Reinforc |Save as e

Objects with matching properties will be included in the group

{ Category Property Condition Value Add row
& Object Object type Equals v Reinforcing bar Bl mar
It 11 » | Mew filter |

Cancel

2. Select a property template for Object Browser. In this example, you
select the Rebar template. For this category, do not select the Include the
highest assembly level in the model check box. If you select to include
only assemblies, you will get all assemblies that contain reinforcing bars.
The highest assembly level for reinforcing bars is cast unit. Create
subcategories based on the nominal diameter.

3. Click Modify to create the category.

You have now created the categories you need and you can start creating
reports.

Next, you will create a concrete quantity take-off and a reinforcing bar quantity
take-off for specific objects in a specific location.

NOTE You can customize Categories to open with a set of default categories
to avoid creating frequently used categories for each project. Export
the desired categories (page 61) in the xm1 formatas a .category
file. Save the file to your firm folder under \ProjectOrganizerData.

Example: Create a concrete quantity take-off using
Organizer

You will now get the quantities (page 6) and formwork areas for the columns
on the first floor. You need accurate quantities to order materials (formwork
plywood and concrete), or just to plan your work.

1. Select the Floor 1 and Column categories in the category tree.

2. Select a property template for quantity take-offs. Object Browser now
shows the quantities of the columns on the first floor.
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& Organizer

Object Browser v
i ,f IQuanthy takeoff - Modify  [v] Show from model  [+] Show from Categor i 3
Name & Grid position Material | Profile  Length/mm Volume / m3 Top level / mm  Section Floor
COLUMN | 3/F C30/37 400%40 32000 0.5 34000 Frame | Floorl
COLUMN | 4/F C30/37 | 400%40 32000 05 34000 Frame Floorl
COLUMN | 5/F C30/37 400740 32000 0,5 34000 Frame Floorl
COLUMN | 5/E C30/37 400%40 28166 04 30166 Frame | Floorl
COLUMN | 3/E C30/37 400240 28000 04 30000 Frame | Floorl
COLUMN | 3/D C30/37 | 400%40 2 800,0 04 30000 Frame | Floorl
COLUMN | 3/C C30/37 400440 2 800,0 04 30000 Frame | Floorl
COLUMN | 3/A C30/37 400740 28000 04 30000 Frame Floorl
COLUMN | 4/A C30/37  400%40 2 800,0 04 30000 Frame | Floorl
COLUMN | 5/A C30/37 400240 2 800,0 04 30000 Frame |Floorl
COLUMN | 6/A C30/37 | 400%40 28166 04 30166 Frame | Floorl
COLUMN | 6&/B C30/37 | 400%40 28166 04 30166 Frame Floorl
COLUMN | 6/C C30/37 | 400%40 28166 04 30166 Frame | Floorl
COLUMN | 6/D C30/37 | 400%40 28166 04 30166 Frame | Floorl
COLUMN | 5/D C30/37 | 400%40 28166 04 30166 Frame | Floorl
COLUMN ' 4/E C30/37  400%40 2 8000 04 30000 Frame Floor1l
COLUMN 4/D C30/37 400740 2 800,0 04 30000 Frame Floorl
COLUMN | 4/C C30/37 |400*40 2 800,0 04 30000 Frame | Floorl
COLUMN ' 4/B C30/37 400740 2 800,0 04 30000 Frame | Floorl
Number of objects in the table: 19 Result of:| Total v | Of these rows:| al v

54 499,5 87

In this example, you have 19 columns with a total volume of 8.7 m3. You
can now create a report by exporting, or you can just check the objects
individually. Or, you can just use the total volume and call the concrete
supplier to order the needed concrete to the site.

Select a property template for formwork. Using a different property
template allows you to get different information on your selection.
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& Organizer

—

> f | Formwark columns, walls and footings ~ | Modify (v Shaw from madel [+ Show from Cz | = 5

Name 4 Grid position Formwork area /f m2 Section Floor

COLUMMN | 3/F 31 Frame Floorl
COLUMM  4/F 51 Frame Floor1l
COLUMM | 5/F 52 Frame | Floor1
COLUMMN S/E 47 Frame | Floorl
COLUMM | 3/E 4,5 Frame  Floor1
COLUMN  3/D 45 Frame  Floor 1
COLUMN  3/C 45 Frame  Floor1l
COLUMN  3/A 45 Frame  Floor 1
COLUMN  4/A 45 Frame | Floorl
COLUMM  5/A 4,5 Frame  Floor1
COLUMN 6/A 47 Frame  Floorl
COLUMN 6/B 47 Frame  Floor1
COLUMN  &/C 47 Frame | Floorl
COLUMM &/D 4,7 Frame | Floorl
COLUMN | 5/D 4,7 Frame | Floor1
COLUMN 4/E 45 Frame | Floorl
COLUMN 4/D 4,5 Frame  Floor1
COLUMN  4/C 45 Frame  Floor 1
COLUMN 4/B 45 Frame  Floor1
Number of objects in the table: 19 Resultof:lTotal ~ | Of these rows:| Al il
88,4

You now get the total formwork area for columns. The formwork area is
calculated using a formula (page 27). You can also see the individual
formwork area of each column.

To check for discrepancies, you can select columns and locate them in the
model for visual checking:

a. Select the columns in Objects Browser.
b. Right-click on the selected rows and select Select in the model.

c. Press Ctrl+5 to show only the selected columns. Other objects are
almost completely transparent.

d. Press Ctrl+4 to show the object surfaces again.
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& (rganizer

—

¥ | X Formwork columns, walls and footings ~ | Medify (/] Show from model  [v] Show fro

™. Name « Grid position Formwork area / m2 Section Floor

—_ Select in the model [

COLUMN | 3/F !

COLUMN | 5/ Add the selected obj to the selected categories

COLUMN | 3/E - ) . )
lemove the selected objects from the selected categories

COLUMN | 3/D Remove the selected objects from the selecte tegorie

Next, you will create a quantity take-off for the reinforcing bars in the first floor
columns.

Example: Create a reinforcing bar quantity take-off using
Organizer

You will now get the quantities (page 6) of the reinforcing bars of the columns
on the first floor.

1. Select the Floor 1 and Reinforcement categories, and the Column
subcategory.

2. Click = to view the categories as unions and intersections in the
selection pane, as shown in the image below. In this example, you need
the intersections of the categories.
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i! [No highlight or selectioni .. =

w

[ —

» ©

[ i

—_—

Select categories above to create
unions and intersections. Drag
categories between fields to modify
the unions and intersections.

‘_ Floor 1 x‘

COLUMN X|

)

‘_ Reinforcement N‘

Object Browser shows the reinforcing bars that belong to the columns on
Floor 1 using a combination of the property templates of all the selected
categories. You can select a different property template to view other
properties, and change the grouping and sorting of the properties.

& Organizer
v
- f [Combéned template - | Modify ZI Show from model Izl Show from Categories +~LE = 3
Size & X

Name & Content type Material type Material  Position number Profile  Top level /m Height/ mm | Length /mm Widt
P Size: 8.0(57)

£1 5100
¥ Size: 25.0(76)
303 0000
Number of objects in the table: 133 Result of: :Iotal ': Of these rows:ihlr ':
384 510,0

You can change your category selection for different union and
intersection combinations. For example, you can add more than one floor
category to get a union of the categories.
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1.14

P 5 Highliaht obiects in the model ~ | Mg =

—_— [S—

» ©

Select categories above to create unions and intersections.
Drag categories between fields to modify the unions and
intersections.

| Floor 1 X“| Floor2 X

|Reinforcement )(‘

| COLUMN X |

Drop the category here to create a new row.

3. Click Export I* to create an Excel file (page 61) of your selection.

If you need the same report often, you can save your selection as a new
category and set the desired template as the default property template. You
can use categories in the rules to define the content of the new category. This
is useful especially when you are building your model, and want to
automatically include model changes in the category.

Example: Track modeling and planning issues using
Organizer

You can use Organizer to highlight objects with certain properties. This
functionality is useful for detailers and contractors, or anyone who wants to
check abnormalities during modeling or planning.

Example: Track reinforcing bar length using Organizer

In this example, the maximum reinforcing bar length in your stock is 12
meters. All the reinforcing bars in your model should therefore be under 12
meters. You can use Organizer to track reinforcing bars that are longer than
12 meters.

1. Create a new category and name it Rebar length over 12 m in Category
Properties. Click Object group to create a filter for the category and set it
up as shown in the image below. The value is shown in millimeters.
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& Object Group - Organizer
Save/Load

rebar over 12m T Save rebar over 12m Save as >>

Objects with matching properties will be included in the group

{ Category Property Condition Value And/... Add row |
Reinforcing bar  Length Greater than  12000.00 And
LS Object Object type Equals w Reinfarcing bar And
MNew filter
Cancel
- L

Save the filter with a unique name using Save as.

In Category Properties, add the filter you created to the rule box, and an
Object Browser property template if needed. Note that if you select the
Include the highest assembly level in the model check box, you will get
the assemblies and cast units that contain reinforcing bars longer than 12
meters.

Click Modify. The reinforcing bars that are longer than 12 meters are now
included in the category. In this example, there are 208 reinforcing bars
longer than 12 meters.

Select the category and view the content in Object Browser. You can
group the reinforcing bars in the category based on their length or
location, for example. You can also select them in the model through
category, or select them in the Object Browser listing and right-click to
select them in the model.
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A Organizer

Object Browser

i f lﬁ'ﬁbﬂr '] i “ﬂdw_ E] Show from model Show from Categories [N _=E‘ _E:'_ ) [ad | E

Name = | Size /mm Rebar shape Grade Quantity | Weight of single bar / kg 'Weight of group / kg Length / mm  Section F
BOTTOM_BAR 01 Undefined 1 70 7.0 17 830,0 | Frame |
BOTTOM_BAR 01 Undefined 1 7.0 7.0 17 830.0 Frame |1
EOTTOM_BAR 501 Undefined 1 70 0 17 8300 Frame ||
BOTTOM_BAR 801 Undefined 1 70 7.0 17 830,0 | Frame |
BOTTOM_BAR ED 1 Undefined 1 70 7.0 17 8300 Frame ||
BOTTOM_BAR 801 Undefined 1 7.0 7.0 17 8300 Frame |
BOTTOM_BAR 01 Undefined 1 7.0 7.0 17 8300 Frame ||
BOTTOM_BAR 801 Undefined 1 70 70 17 8300 Frame |
BOTTOM_BAR 01 Undefined 1 70 7.0 17 8300 Frame |
BOTTOM_BAR 01 Undefined 1 70 7.0 17 830.0 Frame |1
BOTTOM_BAR 801 Undefined 1 70 Ay 17 830.0 Frame |
BOTTOM_BAR 801 Undefined 1 70 0 17 830,0 | Frame |
BOTTOM_BAR &0 1 Undefined 1 70 7.0 17 8300 Frame |1
BOTTOM_BAR 2501 Undefined 4 553 212 14 3500 | Frame ||
BOTTOM_BAR 2501 Undefined 4 55,3 2212 14 3500 Frame ||
BOTTOM_BAR 2501 Undefined 4 35,3 2212 14 3500 Frame |
BOTTOM_BAR 01 Undefined 28 a8 2757 249300 Frame ||
BOTTOM_BAR 801 Undefined 1 53 5.3 13 32000 | Frame |
BOTTOM_BAR B0 1 Undefined 1 53 53 13 3200 Frame ||
BOTTOM_BAR 801 Undefined 1 53 53 133200 Frame |1
BOTTOM_BAR 801 Undefined 1 53 5.3 13 3200 Frame |
BOTTOM_BAR 01 Undefined 1 33 33 133200 Frame ||
BOTTOM_BAR 01 Undefined 1 53 5.3 133200 Frame ||
BOTTOM_BAR &0 1 Undefined 1 53 53 133200 Frame ||
Mumber of objects in the table: 208 Result of:| Total v | Of these rows:

17270 578,000 1566,0 44245 35339300

Before your floor will go to fabrication, you may want to do a final check.
You can select the Floor 2 and Rebar length over 12 m categories to
check if there are any reinforcing bars that are too long on the floor. In
this example, there are 9 such bars.
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& Crganizer & — 0O x

¥ ¥
= & | Combined template | Modify Show from model  [w] Show fram Categori = 3 F ik
MNarne & Sire fram | Rebar shape Grade Quartity Weight of single bar f kg | Weight of group / kg (L) Floor 4 (484)
BOTTOM_BAR 250[1 Undefined 4 553 212 0 Floor 3 (478)
REBAR 801 Unaefined 1 57 57 —
Reas o)1 ndeties 1 57 57
SLAE EDGE BAR 801 Undefined ] 101 201 D Floor 1 237)
SLAE EDGE BAR 801 Undefined F 14 14,5 T
SLAB EDGE BAR 801 Undefined 2 120 240 RiBcoc)
SLABE EDGE BAR B8O 1 Undefined 2 72 145 [ Ramp (14)
SLAE EDGE BAR B0l Undefined 2 49 99 & Property Cat o
TOR_BAR 1201 Undefined 2 127 255 TRery regoy
¥ B Reinforcement (4825/4825)
¥ 11 Object (399/399)
Rebar length over 12 m
] | Rebar length aver 12... ¥ | i
Number of objects in the tables 9 Result of. Total ¥ | Of these rows:| A8 - i)
93,0 18,000 1208 3409 | Floor2 X |

Other possible use cases

You can also check reference models that contain reinforcing bars. In this
example, the IFC model has been created with Tekla Structures.

1. First, create a filter as shown in the image below. Click to set the filter
type to Organizer.

Then, create a new category using this filter.

3. Ensure that your reference model is subdivided to be able to include
reference objects to categories.

& Object Group - Selection Filter
Save/Load

(=]
ifc rebar over 12m - ifc rebar over 12m Save as >

Objects with matching properties can be selected

{ Category Property Condition Value Add row
C] Template EXTERNALTekla Reinforcement.Length  Greater than 12000

Delete row

Maove down

] In ] b || New filter
o] [aenly
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TIP If you have a reference model that has been created with some other software,
an easy way to find out the string for the filter is to use the Inquire command.
Select an object and right-click. Find the desired value string from the Inquire
dialog box, and copy and paste the value as a property to the filter dialog box,

and add EXTERNAL. in front of the property name.

Example: Track too heavy precast elements from a

reference model using Organizer
You can track precast element weights in Organizer by creating selection
filters.

1.
2.

Create a new category.
Create filters to track precast element weights.
a. Create afilter to track a weight over 10 tonnes.

& Object Group - Selection Filter
Save/Load
IFC Weight over 10000kg * |Save IFC Weight over 10000kg |Save as B2
Objects with matching properties can be selected
( Category Property Condition Value Add row
=i Template EXTERMNAL Default WEIGHT Greater than 10000.00
« 2 MNew filter |
OK | Apply Cancel |
b. Create a filter to track a weight under 1 tonne.
& Object Group - Selection Filter ==
Save/Load
IFC Weight under 10000kg - |Save IFC Weight under 10000kg |Save as =
Objects with matching properties can be selected
{ Category Property Condition Value . Add row
v Template EXTERNAL Default WEIGHT Less than 10000.00
« b New filter
(o] 8 Il Apply J | Cancel
c. Create afilter to track a weight within a certain limit.
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& Object Group - Selection Filter ==

=
Save/Load
IFC Weight 7700-8500kg ~ |Save IFC Weight 7700-8500kg |Save as [ >
Objects with matching properties can be selected
( Category  Property Condition Value )} And/.. [ Add row ]
v Template EXTERMALDefault WEIGHT  Greater than  7700.00 And
= Template EXTERNALDefaultWEIGHT  Less than 8500.00
l MNew filter J

[_ox ][ epy | [cancel )

3. When you have created the category and the filters, add a suitable filter to
the category property rules and save the category.

NOTE You can also use this similar process with Tekla Structures objects, for
example, to track both steel assembly and cast unit weights with one filter.
Here is an example of such a filter:

& Cibject Group - Selection Filter [t
Save/Load
Weight less than 13000kg - .Save Weight less than 13000kg .Save as | >> |

Objects with matching properties can be selected

{ Category  Property Condition Value ) And/.. | Add row
= Template  HIERARCHY_LEVEL Equals 0 And
L Template WEIGHT_MET Less than 13000.00 And
CI Template CONTENTTYPE Equals CAST_UNIT Or
s Template CONTENTTYPE Equals ASSEMBLY )
Mew filter
OK ] Apply | . Cancel |

This filter selects all steel assemblies and concrete cast units that are under 13
tonnes. The hierarchy level attribute is needed to get the main assembly
weight.

Example: Create weight group categories to track different
weights using Organizer
You can create selection filters to track different weights in Organizer.

1. Create a suitable filter to create categories for weights, for example,

Weight 5 - 10t asshown inthe image below. Click to set the filter
type to Organizer.

Organizer 83 Example: Track modeling and planning issues
using Organizer



& Object Group - Selection Filter =
SavefLoad

Weight 5 - 10t - |Save Weight 5 - 10t Save as £

Objects with matching properties can be selected

[ Category  Property Condition Value ) And/... | Add row |
M Template WEIGHT_NET Greater or equal 500 And
i Template  WEIGHT_NET Less or equal 10000 )] And
o Template CONTENTTYPE Equals CAST_UNIT And
W Template HIERARCHY_LEVEL Equals 0
| New filter |
ok ][ o ] | Concel |

2. You can now create categories for the weight intervals and track locations.
You can use the categories like other categories, for example, you could
track first floor weights. You can also use the same logic with other
properties, such as volume, length, and area. Adjust the filter rules
depending on what you want to track.

> B Weight (-/365)
3T Weight <5t (264)
3T Weight 5..10t (65)
3T Weight 10..15t (18)

Weight = 15t

Example: Track large concrete volumes using Organizer

It may sometimes happen that the volumes in the model accidentally exceed
certain limits. Such limits could be the daily pour rate and delivery rate. You
can use Organizer to track the limits.

1. Create a new category and name the category as Pour volume over
140m3.

2. In Category Properties, click Object group to create a filter for selecting
volumes larger than the daily delivery maximum and set it up as shown in

the image below. In this example, the daily delivery limit is 140 m3. The
unit is mm3,
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& Object Group - Organizer
Save/Load

volume over daily limit hd volume over daily limit  |Save as >

Objects with matching properties will be included in the group

( Category Property Condition Value And/.. Add row
B Template VOLUME Greater than  140000000000.00 Delete row
Move up
Maove do

New filter
Cancel

3. Add the filter you created in the category rules and select the Include the
highest assembly level in the model check box. Save the category
properties.

Note that if you are doing this with pour objects as shown in the image
below, use a pour object filter and do not select the Include the highest
assembly level in the model check box.

*
¥
F oy

» W Project (2744)

@& Property Category (-]

Pours over 140m3

Reinfarcement (4825/4825)

» T Object (399/399)

W Rebar length aver 12 m (208)

B Layout Points {-)

13e Design Status (User Defined Attribute) LE
&% Organizer i :
i » 11 Material (671/1342)
bject Brow \
- - e 1 erofile (67171342
B Po = | Modi | Show fr del [+ Show from Ca |2
& 1 [pours | fy| (7] Show from model (] Show from Ca (5] [T i b W Embeds & anchor balts {385/385)
Pour Mumber & Pour Type Material Concrete Mixture | Volume f m3 .
ih W Pams (312/312)
4 Slab C30/37 100450 1452
6 Slab €30/37  100/50 1531 P W Pours 113/113)
] Slab C30/37 100450 1544 ik W Weight (528/528)
10 Slab C30/37 1544
i2 Slab C30/37 1551
niber ot objects in the table: 5 Result of:| Total ~ | Of these rows:| Al ul ~
7623 £|No highlight or sebection in - = ii

You can now start planning based on the result. For example, you may need a
bigger crane, or maybe the elements should be smaller. Perhaps the four
pours you have should be divided into smaller pours, or maybe you need
more concrete delivered to the site.
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1.15 Example: Report areas based on object groups in
Organizer

In this example, you will use property categories to create a report on different
area calculations for the selected object groups.

First you will create property categories to define the group of objects that
need different area calculations. Then you will create formulas for the area
calculations, and finally you will add the formulas to the corresponding
categories to write the formula results to the model objects. As a result, the
objects in the different categories will have different area values in the report.

& Organizer ﬂn - 0O X
. T T

% [} 2reo cotcuitoed < Modiy =S ¥ [2 +
{'Name & Conten LENGTH | WIDTH/ Ares_calculsted/m2 | |
| STAIRCASE | PART & 000 200 240 =i & Structural area (1)

T STAIRCASE | PART 6 000 200 1'”“""“.‘ Architecture area (1]
: STAIRCASE | PART & 000 200 5-2.3."---]...,“_'h o

[f.'.l-q

® MNormial area (7111)
L :: Design Status (User Defin

Murnber of cbjects in the tables 3 Result of:| Toud |
' 18000 600 sso7 | @2 Nerevsne . Mg &

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Create a property category (page 41).
Add all model objects to the property category, and create subcategories

for the different area calculations you need. You can use object " or

assembly I type of categories according to your needs. To use
assemblies, select the Include the highest assembly level in the model
option in the category properties.

Organizer 86 Example: Report areas based on object groups in
Organizer



® Organizes «H -

4 =

= Area calcultsed ~  Modify =
MHame & Contentbype LEMGTH/ mem  WIDTH / mm  Ares_caleulsted £ il -l Project (7505)
b Category: Mrea definstion [3325) 1 Uncategedized (288)
2712 389 524 454 35.273.76 v [0 Sie 721D
b Selection from the modet (1) —
9375 300 1807 v 11 Project status (1837)

n Saructural area (5)
11 acchitecture ares (18)

Marmal area [3304)

¥ 3o Design Status (User Defined

¥ oa Matensl (36T2T3e4)

Create a property (page 26) to report the calculated areas.
Open the Settings dialog box in Organizer,

&

O < x

and create the property using the following settings:
* Name:Area calculated

* Property: Area calculated

* Unit type: Area

+ Data type: Number with decimals

* Property type: UDA

LT LR | Columns

l'a"“ MName Ascending
Create Property X
Mame: Area_calculated
Property: Area_calculated
Unit type Data type Property type
|.ﬂ.rea '] MNurmnber with decimals (Dv = | | UDA v
OK  Cancel

— S —
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column in Object Browser, and click Modify.

Settings

Linits Synchronization Colors

Property temp ate: | Asga ealewlated

Drag columns here 1o form groups.

Toolbar

- X[ modity | setasdefauit + Tempiate.

Add the property to the property template you are using to show it as a

x

Color set [Delaul! ']

Properties + Custom= | Columns =®
CLare | Group: [an - =
Drag and drop properties from this list to the columns on the right. LENGTH Ascending Unit *
AREA # | sum row show | Result -
Area_Arch

- In combined row show Single value -
Area_calculated
AREA_FORM_BOTTSM

oR B LENGTH X
AREA_FORM_SIDE
AREA_FORM_TOR
AREA_GROSS —
AREA_NET WIDTH Unit x
ARES_MNGX _—
AREA MGY In sum row show Result -
AREA_NGZ In combined row show :Single walue ']
Area_Normal
AREA_NX WIDTH X
AREA_NY
AREA_NZ
AREA_PER_TONS —_—
AREA_PGX Area_caloulated Ascending Unit S

£a B -
AREA PGY In sum row show Result -
AREA PGZ B —
AREA_PLAN In combined row show Single valug -
AREA_PROJECTION_GXY_GROSS
AREA_PROVECTION_GIY_MET Asea_calculated %
AREA_PROJECTION_GKZ_GROSS
AREA BROIECTON SY7 WNET
5. Create separate formulas (page 27) for the categories.
e LA | Columns
[,.u.," |Length | Ascending

Create Formula

Mame: |.-'3.rea Arch

bt

S B S 0 SN A S ) mm—m

[|_ LENGTHX | |*| | WIDTH x|]

Unit type

i Area
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Create Formula x

Mame: |Area Struct

[|wln'r|-|x| [« | LENGTH x || 2 x”

Unit type

A (4]

+

Area -

L'Emt:‘ ‘Cnnul‘

Create Formula b4

Mame: |Area_Normal

Unit type

| Area -

‘Crﬂu Eanul.l

6. Add the property and the formulas you created to the Area definition
categories to write the UDA values to the model objects.

a. Addthe Area calculated property in the category properties of the
root-level Area definition category.
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Remerae the selecte

Mew suubcategony

telect o the meddel

F'r-:-p:ftr.;-

Synechronize the category. Las

Search for the property in Object properties, select it, and click
Modify.

¥
Category Properties LR
. ¥ Il Project (7505
- I proe
I cwrcansd for roduct
) I Appres i
Automated object content A
Automated subdalegedicn -
[ wnclude the highest stsembly beve —
s
% Object propertiey e
-
" el e
Type Vadise Unit ¥ o Des
Murnber with decin 5q Meter [mI) x 301
Arpa_caloulated v Faa
b u
& Updat
#l .
Dedult - P mE
Delete Category Modify  (lese

Add a value to the property in the category properties of each lowest-
level subcategory.
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Rerame

Derlete

Properes
Lol %

. L
S P = e

Formula

Type:
Value: Select a formula you previously created.
x

Category Properties

Awtomated object content
Auitoimated subalegonies

* Manally sdded objects
& Include the highest assembly level in the mode

% Object propertics
nd theew values to the clgects in this categony tree o write them to the made
Walue Linit

Sef the properties
Irherit Type
wakar

Formuls Area_Struct
Category Prepertien x
e [
Rules for setting category conte
Asgtomated object contemt
Astomated subcategories
Manially sdded objects [ Manualy removed objects
BB Inchude the highest sssembly level in the modedl
T Object properties
Set the peoperties and their values 1o the objects in this category bree 1o weite them 1o the made
Inkeit Type Value Uimit
valise ¥ oa Design st seY
Feamreds = || Area_frch * 7 bate
b 51 Okgect
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—_— S 3

Category Properties

B
b Il Progect
-3
Aubemated sbject content T1 Approved for g
Automated subcategaries 1 cast
¥ Manualy sdded ohjects 1 Delive
I & s sl §Ese e he 2 e
: ) 1 stractu
% Object propertie
Inhueiit Type Vi Uinit | ]
wadue B :' 7 pr Digf
Faermula « || Args_Marms . b 11 Materia
Fi

Synchronize Organizer to calculate the new UDA values and write them to
the model objects.

el - o x
L 3
5 = +[2]

T o

Proprte

SeyTel b o rard B ¢ '

it

View the report in Object Browser.
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The Area_calculated column in Object Browser shows the areas of the
objects according to the categories they belong to.

#F Organizer =] n - 0O X
L ¥

% Area coiculioed = | Modify = F | | 2

Mame i Content type | LENGTH/ mm  WIDTH / mm | Area_calculated / m2 ¥ . Praject {7505)

- Area defimition > Stnsctural area (3) H - tI Prajict Aabus (1837)

44an 5345 6365 ::I Appetnnd Tor production (1203)
STAIRCASE CAST UK 4470 200 1.7
STAIRCASE | CAST_UNIT 4642 200 186 I carzn
STAIRCASE CAST_Unm 4470 200 .79 1 Delivered (307
STAIRCASE CAST_ Ut 4642 200 1.86 w ] T Asea definition (3385)
STAIRCASE A | CAST UkaT 6 200 4545 56.36 el e
- Area defiration > Aechitecture sea (18] Strsctural area
24 G 14 378 1B6.T3 Aschitectune area

PANEL CAST_UraT B 055 ] 4.83 I
PANEL CAST U 1022 2] o141 r— .
PANEL CAST_UMIT 30344 500 1221 P ga Dessgn Stabus [User Defined Attribute]) (36
PAMEL CAST_Unm 2 s 00 123 v 31 Material (367277344
PAMEL CAST_UMIT & 255 &00 LAY p 1Y Object (357203672
PANEL CAST _UraT 17815 00 1069
BaNEL CAST_UraT - B0 433 | E'h:_||r1_¢|.r-| Bt gl |_I‘,r.;|.;qr||qr!' 13
PAMNEL CAST_UnIT 62 540 L] 3752 ¢ B FC model (3553581
PAMEL CAST_UMIT 700 00 452 ¢ B Renforcement (205002850
PAMNEL CAST_UikaT 1978 ] 114
PANEL CAST_UnaT 147 2] 1588
PAMNEL CAST UMIT 1380 500 208
PAMEL CAST_UnIT 11 580 A ETE 15
PANEL CAST_UKIT 17450 200 144
PaMNEL CAST_Lika 5 552 a2 11.67
FAMNEL CAST_LNIT Tras 200 F.48
- Arca delindica = Bormad anca [33564)

G &4 D6 504 77O 3502339
BASE PLATE ASSEMEBLY L 430 0
BASE PLATE | ASSEMBLY 500 4 029
BASE MLATE | ASSEMBLY 500 480 029
BASE PLATE | ASSEMBLY S LE] 0.2
Humber of objects in the table: 3387 Resuit of:| Yo = | Of these rows:

9721501 624894 35 277401 B [Fororsor ormacsonmoe | ) (2

1.16 Example: Calculate and report areas based on object

type and project status in Organizer

In this example, you will create property categories based on the project
status. During the project you will move the objects between the categories to
reflect the current status of the objects. You will also create property
categories to report the area calculations for the selected object groups.

You will combine the properties that the project status and area calculation

property categories add to the objects. The report will not show any values for
the areas of the objects that are early in the delivery chain, but it shows object
type-specific areas for the rest of the objects that are in the later phases in the
delivery chain.

To report area values, you will set up two conditions for special area reporting:

Example: Calculate and report areas based on
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+ Do not show the area of the objects if the project status is Approved for
production, but show the area if the project status is something else.

+ Calculate the area based on a predefined categorization of the objects.

A Cipganaer ﬂn = O X
" v . v
B meopoiammn - Moty E8 =L *+ 0
Marme  Content type | LEMGTHIS mm  WIDTH Y mm | Ares_caboolabed / md | Ares_boe_propsot_status / md Y —
¥ Category Project status » Appeoved hor peosfudction [1501) Uscategerced (288)
6 TE 103 5 FAL AT i v [ Ste 27
b Categery Progectststus > Cast 27 —
19124 1 535 802 028 = [ Prcject etaben {1637}
¥ Cotegery Project ititus = Deleennd {307) Fgppiird dor produisn
1472 155 b TEHL5 TEN.5 Casd
¥ Seection frem the modet (1) [ ——
LRI & B B — ;
w | L e defnifeon (13050
n Srructusi srea (]
T Aechitectues ama [15)
n Mermal seca [3358)
b I3 Design Sates (User Defined Ankte) (BT ETH
v 17 Material (36T T34}
o Crganizer el - o x
v v
& B s forpriectionn < | Moty ER EE ]
Marne Cosbesttype  LENGTH men WOOTH v sea_calOulabed / m2 | Area_for_peoject_stabs / md w I Progect (7505)
= Cptegory Project tatur = Appeoved for produsten (1R ] Ussategenzed (228)
& T 00 13 1 H A 09 v [0 St 200
BEAM  ASSEMELY 10 E&5 185 2058 - —
BEAAE | ASSEMELY LLRE] g Wit w I Pregect states (1237
BEAM  ASSEMELY 11354 3 1i] 21.33 Appierersd bor paosducton
BEAME | ASREMELY 10 F no i .
BEAM ASSEMELY 100489 0 1ETE
BEAMY  ASSEMELY 2057 m FeT Diclraried
BEAM  ASSEMELY BTE ] ¥ w 11 Asea deferawon (3335
BEAM  ASSEMELY 28 13 300 q
feructuesl ares (9
BEAM  ASSEMELY 1 18 180 1452 o
BEAM | ASSEMIELY Iz 20 042 [T Aechitactums ssea (16}
BEAME  ASGEMELY fl4 ] 156 T rhoermal anca (3360
BEAM ASSEMELY 4 ET7 Ed 3140 [T] -
¥ 31 Diiige Staten (Uner Definad Attribute) (35723672
BEAM | ASSIMELY ] " % .,_| g a den £ nibadia] i

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Setup the rules for project status.

First create property categories to define the project statuses of the
objects. Then create a property that you will add to these categories to
define whether certain report fields get values.

a. Create a property category (page 41) for the project statuses.
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Add all model objects, or a smaller set of objects, to the root-level
category, and then create subcategories according to the project
statuses.

I Oepanizer ﬂ‘n = 0O X
¥ ¥
F Bl frosect stans quaeenes < Modify =3 = * O
M i Continl gk Weight ) e ¥ - Progeci { T
b Project status » Approved for peoduction (1503 v [] Propect szanss (1237
1l e}
F Project stahn » Cast (27
03 E44
F Prgadt flatud > Dhlrstrid (307
4 105742
il
Qoo
Rlanbar O GEHECIS i Ui LIl 1237 Fiesult o Tokal ¥ | O these now
[ = a
4 609586 @ inkeceoeh E -

You can use object " or assembly I type of categories according
to your needs. To use assemblies, select the Include the highest
assembly level in the model option in the category properties.

Create a property (page 26) for the calculations.
Open the Settings dialog box in Organizer,

GH - © x

v
J

and create the property using the following settings:
* Name: Quantity output

* Property: Quantity output

* Unit type: No unit

+ Data type: Number without decimals

* Property type: UDA
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Settings

Units Synchronization Colors Toolbar

Property template: Project status quantities ~ | [#&  Modify Set asdefault < Template Import  Export
Colar set: |Defau|t '|
Properties L XA | Columns +
. Formula
Property Height Unit x
Drag and drop properties from this S R -
Create Property X
Name: Quantity_output
Property: Quantity_output
Init type Data type roperty type )
Unit type ...3.3 typ Property type Uit %
Ma unit * | | Number without decimals '| UDA v
-
OK  Cancel

Add the created property to the Project status categories to write
the values to the model objects. You can then use the values in
further calculations.

* Addthe Quantity output property in the category properties of
the root-level Project status category.

4.i-"|-"!'

Uncategorized (238

I‘I A
I‘I il
1 oe

w | | Area del Mew subcategory
11 sruce _
H Select i the mode
I—I Marem Ftmaime

b: : Design Lhelete

b 13 Mot

» % Object Propertees *

Synchronize the categony, Last sync

Search for the property in Object properties, select it, and click
Modify.
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() oot ther Pigimarie aiiemabsty bl 5 thee srasated

Sl Thae proqperiie nd e vibses 10 The DibgsCls in tht Ccategory tnee bowrile them 1o The model

quan|

Property tempiate: | Dol > |

Set the properties and their values to the objects in this category tree 1o write them 10 the model

Property Type Value Unit
Quantity_output [Nurnbel' without deci ~ I[ |

[ Select o property.

[#) Update category at synchronization

Property template: | Default «

Delete Category. [ Modity | Close.

Add a value of the property in the category properties of each
lowest-level subcategory.
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In the Value box, add value 0 where you do not want to have any
output, and add 1 where you want to have output. You have to set
the value in each lowest-level subcategory.

Caegory Properies K

Hemes | enrrnipd Tor prodiction {nE

i Prgped! ifdtud = Apdvivid fior produstion
Bigles fior setting category content

b
b
i Manially shied sbiecis
] Inchude the highest sssembly level in the model

St iRt properiies and thar walues be the oliperts i this categosy ot Do wete them Do the modd

Pregerty inkevit Ty Wakur Linkt
Wikt

Cruardity_cetped ] Mumberwithoutdy -~ 2

EUpd.l'.l-:rhrgm-_flwnﬂmam:.ﬂm

Fropartytemplete | Defeult ~

Jslala Catagary, ally, e
Categeey Propertas w
Mame [Coo |

w3 Proprct ptodur = Cagl

Fiules o0 sty cabegary oonbent

‘b Maresally sdded cbjocty |
B e mhe Paggheesn ssembly level i the moddl

St the prepartans and Ehepr values o the obpects in By catagony tree BS write Them Bo the mesdal

Propedty Fishaetin Frpe Wabr Uit
walue
Sty outpt || Humberwakeutr - |1

A Updebe cateqory st perctereaization
Property teenglabe | Delsull =

Set up the rules for area calculation.

First you will create property categories to define the group of objects that
need different area calculations. Then you will create formulas for the
area calculations, and finally you will add the formulas to the
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corresponding categories to write the formula results to the model
objects.

a. Create a property category for area calculations.

Add to the category the same model objects that you have added to
the Project status category. Create subcategories according to the

area calculation types. Use the same type of category, object " or

assembly u , as in the Project status category.

& Organizes 'ﬂn
et Bi - T bR
3 Bl prect st quananies - Moty ES s
Marme & Contenttype Wesght [t Area_calculated [ m2 w I Project (7505
w Categon: Asea definition » Stnactural anea (5] | 1 Uncategorized (288
324308 £3.65 v Steqeim

w I Project status (1837)

1 sppered for production [1503)

E can iz

» Citegory: Ases defintion » Archecturs sres (1) L1 Delvered (307)
1285540 18673
PANEL CAST_UNIT HeEd i8] Strustunal srea
PANEL CAST UNIT 6817 0.8 .
PANEL CAST_LUNIT 190,074 TF] Architechee aera
PANEL CAST_UNIT 12814 123 Horeal area
PANEL CAST_UNIT WA 183 + TF Decige Stz Uicer Defined Attibuts)
PAHEL CAST_UNIT 111088 ML . T
PENEL CAET UNIT am e ¥ aa Material (3ET2TH

b. Create a property to report the calculated areas.
Open the Settings dialog box in Organizer,

I

& < x

and create the property using the following settings:
* Name: Area calculated

* Property: Area calculated

* Unit type: Area

+ Data type: Number with decimals

* Property type: UDA
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=+ Custom~ JELITETT
lNl MName Ascending
Create Property >
Mame: Area_calculated
Property: Area_calculated
Unit type Data type Property type
|Area '] Number with decimals (D = | | UDA hd
OK  Cancel

e ——

Add the property to the property template you are using to show it as
a column in Object Browser, and click Modify.

Settings x
Units Synchronization Colors Toolbar
Property template: | Areo calulated ~ X | Modify | Setasdefault + Template import  Expart
Color set [Dglauu -I
Drag columns here to form groups.
Properties + Custom~ | Columns +
i =
Sare | Groupe | All - —
Drag and drop properties from this list to the columns on the right. LENGTH Ascending Unit x
AREA | sum row show Result -
Area_Asch —
In combined row show Single value - |
Area_calculated e —
AREA_FORM_BOTTSIA
L T LEMGTH %
ARES_FORM_SIDE
AREA_FORM_TOP
WIDTH unit x
‘\‘Rm-\.m In sum row show | Resuit -
AREA_NGZ In combined row show | Single value ']
Area_Normal
AREA_NX WIDTH X
AREA_NY
AREA_NZ
AREA_PER_TONS =
AREA_PGX Area_calculated Unit *®
A P - -
AREA PGY In sum row shaw Result M|
AREA PGE B 4
AREA_DLAN In combined row show Single value -

AREA_PROJECTION_GXY_GROSS
ARES_PROMECTION_GXY_MET
AREA_PROJECTION_GXZ_GROSS

ABEA DRAIEFTION Y7 MET

Area_calculated »

c. Create separate formulas (page 27) for all the different area

calculations.
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4+ Custom~ Columns

[AII \Length Ascending

Create Formula )4

Mame: |Area Arch |

[ LENGTHX| | * | WIDTH X ]

Unit type

;MEa -
Create  Cancel

Create Formula *

MName: |Area Struct

Blaiening

[ |LENGTH)¢ o] 2 x

Unit type

;Area -

‘Emh‘ LCanml‘

If you do not need special calculations for every object type, you also

need to create a simple formula using the default area property of
the objects.
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Create Formula =

Name: |Area Normal

Unit type

Area |

Create Cancel

Add the Area calculated property and the formulas to the
category properties of the Area definition categories to write the
values to the model objects.

+ Add the property in the category properties of the root-level Area
definition category.

Search for the property in the Object properties, select it, and
click Modify.
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Proparty Typa WMadar Wrnit
ies_calodned | Munnberwith decima = | || 5q hater (m2) = =
| rea_calculated |
) Update category st mymchronization
e
iieinCatasory, [N

w T Preject statun (1837)

I Approved for prosduct
1 castan

I3 Delivered (307)

I3 sanuctural aves (5)
I tachiecture swes (16
T tooemal sres (3364
» 2T Design Status (User Defirs
# 53 Material (36727344

» 21 Object 36723672

W Engneeing Material Mar
b W IFC models (1863/5881)
¥ W Renforcement (2850288

Add a value to the property in the category properties of each

lowest-level subcategory.
+  Type: Formula

+ Value: Select a formula you previously created.

»» Areo defirndion » Strucioral arca
= Rules for sefting category conkent

Hames ‘Em:uuul area | k1]

W Mansally sdded chjects
) Include the highest assembly level in the model

Set the properties snd thew values to the cbgects in this cstegony tree to write them o the model
Imherit Type Walue Unit
walue

i

Ares_cakulated ] | Fomuts = | Area_Struct -

Hame: [srehitecture area

W Manusalty sdded objects § Manually remeved objects
) Inchude the highest sssemibly level in the model

Set the properties and thair values 1o the chjects in tha Category bree 1o weits tham 1o the model

Freperty Inbserit Type Value et
walise
Area_abulated D |Fﬂlﬂ| ‘-”_qu_M "-'J
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ames armal area

-
» % Area defirnioe » Norsa! ares

¥ I Project (7505)

- n Pregect status [1237)

Rules for sefting < sfegery comtent
Aubomated okject conbent 1T Approved for productie:
A PR
s I Cast 2y
1 Deliwered (M7

w L] &res defraticn (3385)

# Manualy sdded objrcty
[ nclude thee Pegheest sssemibly bevel in the model

Snactural area [5)
LY Dbject propertios n :
I Ascharectune anea (1)
et the properties snd their values 1o the cljects in thit cabegory Eree 1o write them to the medel
Froperty Inhatit Type Walue Unit
value
[ Fesrmula = Area Meemal

Add the area calculations to the Project status categories.

Create a formula that uses the Area calculated property written to the
objects from the Area definition categories, and the Quantity output
property written to the objects from the Project status categories.

erties =+ Custom~ QI

| Group: lﬂecent F--'.'.l"."l‘.l..Jfl- k

Create Formula

Name: |Area_for project_status

L+

SRR

“Ar:a_:alculatedﬂ ; |Quantity_uutputx ]

Unit type
[Area

Create  Cancel

Add the new formula to the property template you are using to show it as
a column in Object Browser, and click Modify.
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Settings x

Units Synchronization Colors Toolbar

perty template Ared for proect status = X Modify  Setasdefault 4 Template Impert  Export
o 2 Default =
Properties + Custom= | Columns +
Group: | Recent - WIDTH Lhnit X
In sum row show Result -
In combined row show Single value -
WIDTH %
Area_caloulated Unit x
In sum revw shaw Result -
In combined row show 5 ngle value -

Area_calculated X

Area_for_project_status Linit ®
In sum row show FResult -
In combined row show Single value ol

Area_for_project_status X

The formula calculates a property value that is shown in the
Area_for_project_status column in Object Browser. If the

Quantity output inthe formulais 1, a property value is shown in
Object Browser. If Quantity output is 0, Organizer does not add a
value to the object property. When the Quantity output valueis 0, the
Area for project statusformula equals Area calculated/O.

Synchronize Organizer to calculate the new UDA values and write them to
the model objects.
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You can either synchronize Organizer, or only the property category tree.

o - o x
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6. View the reportin Object Browser.
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In the image below, the five objects selected in Object Browser have the
area values calculated based on the definition in the Structural area

category.
& Onganis offf - o =
T— L] [ v
& B v topromt v - oty Al =G |
H.r-ll:mlrpr.iiﬁlH.'M WADTH / =m ku_:.iﬂ“'d.'mllhu_himmu.'nﬂ. l.mm
b Casbrgorye Progect shabus o Approved for production (15331 = 1 Broject eaten (1857
£731 100 Bs FITT e
w Category Progect sabas > Cast [27)
11 11505 e o
STk | CAST UNT 10 2% ¥1.23 ¥1.23
ST | CAST UWT 408 0 [ ] T 2
SUAR1 | CAST UNIT 7em 20 1.0 (i FE
AR | CAST UMT 1500 e 1424 1434 Rrachad sres (5)
STAR | CAST UNIT A4S e wa A T aschiecrone s (4
Shad | CAST U 140 e H.21 521 1T Hermal area (1364
STk | CAET UnT o) 00 1541 1541 . e
ST CRST UNIT 340 Foe e nm nm a et Sates Lher Detaed Atinkate] (37070
STAR | CAST UWT 3% 200 .7 07 3 Mlsterial ETETIMY
STAR1 | CAST_UNIT 4085 20 56 356 —_— S
STAR | CAST UNT 7300 00 8218 215 £3 Dt (ET2ITI)
TIAR | CAST UNIT A oo e s ¢ B Engneering bsterisl Lunsgement (AT
SEam GRS Ut B0 e e ) bW HC rodels (RERCAE)
TR CRSTUNT 1 - L L) bW Brisicemenst (JEIE5
SUAR | CAST UNIT 4085 2% e )
STAR | CAST UNT 7 200 200 215 5278
STAR1 | CAST_UNIT 4085 e o1 ) L)
Shad | CAST UHT 140 e B BT
STal | CAST UK i = K KT
$hah | CAST unT 408 % e K5
ST | CRST UNT 720 20 [T m
CAST_UNIT 20 2 708

b Cafegore Propect rhabe » Delenred [HOT)

1472155 B 768158 76815
B Selecisen froen the modet )
12 400 héd 1]
Hhernber o bfects o B abde 1839 Ressltod Mem = | these jows 4 -
BEEL 491 4B 324 30 S0L00 FETEL il i P I 1 P e E.E,

In the Approved for production category, the objects have no area values
in the Area_for_project_status column, so the total sumis 0.

& Organicer e - o x
. ¥ || Catogorier T
3 B trotorpropect st | Mty ER & |
Heme Costont type | LENGTH/ men | WIDTH/ men | Avca_calculated / m2 | Anea_for_peoyect_datus / md | w I Projes (TR5)
= Category Project diatun 5 Approved Tor produstion (1505 ] [l Ueaegerized (225)
e 2w 18548 am b B Seriin
BEAM | ASSEMIELY 10885 3 Hse -
BLALT | AtEMELY 018 w 1837 = I Preject st (12
BEAM | ASSEMELY 1133 o na ~
BEARY | ASTEMBLY 10 o Fil] 2
BEAM | ASSEMELY 1008 no %
BEAMY | ASSEMBLY 4057 M B33
BEAM | ASSEMELY TSR ) 2 o 1T Aven definion (3285
BEAM | ASSEMELY 208 By 300
BEAM ASSEMELY 1328 " 13 B
BEAM | ASSEMELY n2 0 nEz T Aochitoctuns awea (16}
BEAME | ASSEMELY ] ) 1% T Mstrnal avea (3364
BEAM | ASSEMELY AETT ] 340 =] o ; p——
BEAM | ASSUMIRY T ] e [] ._: Dt Stabon Lhunr Difnand Attribote) (36T1IET)

NOTE To show the categories as groups, select the Separate categories
option on the Object Browser menu.
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The UDAs added by Organizer are also shown in the Inquire object
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1.17 Example: Add a classification code to objects in
Organizer and export the code to IFC

You can add a classification code to the user-defined attributes of objects
through a property category in Organizer and export the code with the
objects to an IFC file.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
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Create the classification categories that you need as property categories
(page 41).

Property categories have round icons in the category tree.

& Organizer o] - o x

Object Browser v Categories v
=Rome: 28 = |
T ey Y]

To populate this list select abjects from the | * (] Reference models (4139)

v [T 21 Elements 1 (3672)
|+ ® 2101 0000 Substructure (266)
v & 71-01 10 Foundations (265)
» @ 1-01 10 10 Standard Foundations (265)
® 71-01 10 10 10 Wall Foundations (16)
& 71-01 1010 30 Column Foundations (139)
® 21-01 10 1050 Standard Foundation Supplementary Companents (110)
® 21-01 10 20 Special Foundations ()
w @ 71-01 20 Subgrade Enclosures (-]
w & F1-01 30 10 Walls for Subgrade Enclosures (-}

® 21-01 201010 $ubgrad¢ Enclosure Wall Constructicn (-]
w @ 21-01 40 Slabs-On-Grade (1)

& F1-01 40 10 Standard Slabs-on-Grade (1)
® 21-01 60 Water and Gas Mitigation [-)

® 71-01 90 Substructure Relsted Aetivities (-)
MNumber of objects in the table: 0

&

Mo highlight or selecion in the model -| L
1 1

3. Create a custom property that you will use in the classification.

Click Lo in the upper-right corner of Organizer to open the Settings
and click Custom --> Property .

Uniti  Smchiosision  Coken Toolbar

Omriciar. = X Meodily Setadefssit 4 Temglate
A Grganaer Aobarmine.
- v v s m T —
M e B T e N ] ] - | (e pe e —
Saction & Floor Mame Comtent tpe Matensitype | Muterisl | Pochle Uncategsrioed (2] ]
Material type
his = select shjests fram the mmadel o the categeres ¥ ] Reference mosdels (4105
MATERAL T
o8 | assEn
0] | MANS
Materia
MATERIAL &
11010 90 Stand
13 20 Special Four
= @ F01 20 Subjrase Enissn Profile

b. Define the custom property as shown in the image below. Set the

property type to UDA.
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4.

5.

Creabe Froperty

Marme:
Property:

Uit type

| Mo unit

-

. -
Crrerinii_Elernents

0K Cancel

If you want, you can add the property to the objects. inp file to see the
property in the user-defined attributes dialog box.

Add the custom property to a property template.

If you do not have a suitable property template, create a new template

(page 22).

a. Search for the custom property you created and drag it to the

selected template.

Settings

Property template:

Properties

Units

Synchronization

Omniclass

| % Modify Setasdefault < Template

Colors

Toolbar

Drag columns here to form groups.

+ Custom~

I] L elem I

| Group: | Recent

]

Drag and drop properties from this list to the columns on the night.

Omni_Elements

Import  Export

Coler set: | Default -]

L

Material |:::|"::

MATERIAL X| OR |PART.MATERIAL x|

OR | MAINPART MATERIAL x|

Profile |-\::|-;_-

PROFILE :lll:| OR |PART.PROFILE x

OR | MAINPART.PROFILE x

P~

Omni_Elements |:::|‘ g

N

Omni_Elements x |

x

b. Click Modify to save the template and close the settings.

Add the custom property to the property category you created earlier.

Organizer

110

Example: Add a classification code to objects in
Organizer and export the code to IFC



a. Double-click the root property category to open the category
properties.

b. Under Object properties, select the custom property you created.

ol - o x cuegoypropeties X
tegori ¥ || Mame (3 Blements 1 3678)
Elerie (@ . 2 emens:
Uncategorized (2) L] Rules for setting category content

» [T Reference models (4139)

- Select the model to sutomatically add objects to this category hodel list
QO Uncategorized (5) —

T Automated object content

+ @ 21-00 0000 Substructure (266) Tekda Structures madel %

- & 21-01 10 Foundations (265)

» & 71-01 1010 Standard Founds

® 71-01 1010 10 Wall Fount

Add categories or filters to automatically add objects to this category. YObject group...
® 21-01 1010 30 Column Fe
® 21-01 1010 90 Standard F M
® 2101 10 20 Special Foundatic
- ® 210120 Subgrade Enclosures (- [ Include the highest assembly level in the mode
v @ 21-01 20 10 Walls for Subgrac Object progerties
® 21-01 2010 10 Subgrade £ elem .
| Omini_Elements
£ No highlht o 1leHan in e i v ii ProrTTr Ty STy

Property template: | SteelProfildnfo «
Dulute Catopory, Modty, Oors,
c. Click Modify to save the changes.

Now all the subcategories under the property category have the same

custom property. The lowest subcategories will add the custom property
to the objects with the values you will define next.

Set the custom property value in the subcategories to add the value to the
objects.

You can add different property values in all subcategories.
a. Double-click a lowest level subcategory to open category properties.

b. Add the custom property value that you want to write to the objects
in the selected subcategory.
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Profie | Omed Bemenss [ e Dbject properties uied 1o create automated tubestegories undes “11 Elements 1 > 1101 0000 Subbructure
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ndefined 43567800
Mindefned  4350°600 w & 10000 00 Sebstructure (266) | '|
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350
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Mindefned  4350°600
Undefined 435000
Mndefined 4350600 #2100 101090 Stamdard Feundation Su Peoperty [T Trpe Vale Uit
Mindefined 4350600 wakee

e Tontan ® 2101 10 0 Special Foundations [+] . O = [Fawns l

= @ 2100 20 Subgrade Encloses ]

Undefned 41507600

[hincluse the highest assemishy level in the model

T 38 Csburnn Feundstions (1 I [ r—

= & 21002010 Was far Suibiesde Enclosires 2 Ut cavegony o€ pynchemization
® 2101201019 Subgrade Enclosre Wal N o croaym
. Praperty tarplati: [SonaPrafieil » |
Woh[tan v | Of these rows a0 .|
— [ ogrges o s o i = | [y [ || (DS Cotaoery

c. Click Modify to save the changes.

Synchronize the property category to write the property values to the
model objects.

Select any subcategory in the property category, right-click and select
Synchronize category.

The whole category tree is synchronized.
You can check the result in Object Browser, or by inquiring an object.

& Organizer off - o x
—_— ¥ || Categeies v
F n[G\MMlﬂs = | Modity, (] Showtiom model (2] showtrom Categoies [(R | B) B [F 2 |22

Section Floor Mame w Content type  Material type | Material Profile rmini_Elements. {7 Uncategarized () "

Ramp PAMEL | CAST_UNIT |COMCRETE | Concrete Undefined 46007200 | 21-01 101010 » () Reference modes (4139

Ramp PAMEL  CAST_UNIT | COMCRETE | Concrete Undefined 41000200 | 21-01 101010

Famp PANEL  CAST_UMIT | COMCRETE | Concrete Undefined 41007200 | 21-01 2010 10 w [ 7] 21 Blements 1 (3572)

Ramp PAMEL  CAST_UNIT | COMNCRETE | Concrete Undefined 41007200 | 2101101010 w @ 21-01 0000 Substructisre (266)

Section & Basement | PANEL  CAST_UNIT | COMCRETE | Concrete Undefined 4350600 | 2101101010

Section #  Basernent PANEL  CAST_UNIT | CONCRETE | Cancrete Undefined 4350%600 | 2101101010 * @ 21-01 10 Foundlations (265)

Section A Basernent PANEL  CAST_UNIT | COMCRETE | Coneciete Undefined 4350700 | 21-00 101010 » @ 71-01 1010 Standard Feundstions (265)

Section A Basernent | PANEL  CAST_UNIT | COMCRETE | Comcnete Undefined  4350m800 | 21-01 1010 10
Section A Basernent PANEL  CAST UNIT | COMCRETE | Comcrete Undefined 4350700 | 21-00 1010 10
Section & Basernent  PANEL  CAST_UNIT | COMNCRETE | Concrete Undefined 4350600 | 2101 101010 ® 71-01 10 10 30 Columnn Foundations (L
Section A Basenent PAMEL  CAST_UNIT | COMCRETE | Concrete Undefined 43507600 | 21-01 1010 10
Section A Basement PAMEL  CAST_UNIT  COMCRETE | Concrete Undefined 43507600 | 21-01 1010 10
Section A Basement PAMEL  CAST UNIT  COMCRETE | Concrete Undefined 43507600 | 21011010 10 & 101 10 20 Special Foundations ()
Sectiond  Bazemnent PAMEL  CAST UNIT  COMNCRETE | Concrete Undefined 43507600 | 2101101010 * @ 2101 0 Subgrade Enclosures -]
Section & Basement  PANEL  CAST_UNIT | CONCRETE | Conerste Undefined 43507600 | 2101101010

Section A Basernent  PAMEL | CAST_UNIT | CONCRETE | Conerste Undefined 43307600 \Z1-01101010 ¥ ® 21-01 20 10 Walls for Subgrade Enclesuses

® 71-01 20 10 10 Subgrade Enclosure Wal

101 1010 10 Wall Foundations.

® 21-01 10 10 50 Standard Foundation Su

v & H-01 40 Slabs-On-Grade (1)

Mumber of chjects in the table: 16 Resultof:(Tol = | OF these rows:[ & =]

it [ ramareor e nmamse - | My &

Add the classification code to the project properties.

a. Onthe File menu, click Project properties --> User-defined
attributes .

b. Add the classification code to the Classification system box.
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Use the name that you added to the Property option when creating
the custom property.

yiis & design
- General B Pedoemrumberng  ® @ Mumberng peftings ™ E QE Ij'] Phases
. Prcied] @ Tekda Structares Project 1) ) rgaece ’ e
Huondl | Parameters | IFC expet | Gew coondinates | Statun | Unitechnie
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Unertheld 1 ¥
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-] Desgfl  Unertieiad v
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|¢- i | T 7
End i Userfiela T 7
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You can add one classification code at a time this way.
9. Export the classification code to an IFC file.
a. On the File menu, click Export --> IFC .

The classification code is exported with assemblies even if you have
added it to parts.

b. Check the result in the exported model.

¢ ~ > ~[[@

# Assembly.1.11

| Identification I Location I Quantities I Relations | Classification | Hyperlinks I BaseQuantities I Tekla Assembly|

Classification Source Reference MName
Omni_Elements From IFC 21-01 10 10 10 210110 10 10
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1.18 Example: Create a custom category for structural
design status in Organizer

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Create a new category, right-click the category and select Properties.
Enter Design Status (User Defined Attribute) as the name of the
category.

3. Setthe category rules to create automated subcategories using Grouping
in Object Browser based on the design status that has been assigned for
each model part under the UDA.

Category Properties x

Name! |Design Status (User Defined Attribute) (657

== Design Status (User Defined Attribute)
Rules for setting category content

T Automated object content

Select the model to automatically add objects to this categary Madel list
-
Add categoaries or filters to automatically add objects to this category. YObject group... |
|
x |

¥ standard x

T Automated subcategories

Grouping in Object Browser

Object properties used to create automated subcategories under "Design Status (User Defined Attribute
Create subcategores based on: -
MAINPART.PLANS STATUS X | OR |UDA - PLANS_STATUS X
OR | ASSEMBLY.MAINPART.PLANS STATUS X

OR | CAST_UNITMAINPARTPLANS STATUS ¥ OR |PLANS STATUS X

m Update category at synchranization

Property template: | Default ~

Delete Category Modify  Close
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You can now use the categories in managing the structural design status of
your project.

v ﬂ Design Status (User Defined Attribute) (657/657)

Il Ccompleted (218)

Incomplete

I3 No value (385)

See also

Example: Create a custom category for architectural design status in Organizer
(page 115)

Organizer (page 5)

1.19 Example: Create a custom category for architectural

design status in Organizer

Your design team may want to communicate the design status of the parts in
their model to ensure that other project members only focus on areas where
the design has reached maturity.

1. Ensure that the architectural team places an IFC attribute to each object,
such as Architectural Status, which can be included in the IFC file
that they share. In ArchiCAD, this can be done by simply adding an IFC
property to the objects called, for example, Status. In Revit, this can be
done by using the Revit comment attribute found on each Revit Family
Instance.

2. InTekla Structures, use the Add model command to place the
architectural IFC model in the correct location and ensure that the model

is subdivided.
3. To open Organizer, click Manage on the ribbon and then click Organizer.
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Create a new category, right-click the category and select Properties.
Enter Architectural_Status as the category name.

Add the Object type - Reference Object filter to the rule box for
categories and filters, or a locally set filter that will find all reference
objects in the model.

Add categories or filters to automatically add objects to this category.

¥ Object type - Reference object X

Create a new property to allow Tekla Structures to read comments from
the ArchiCAD / Revit IFC file. To find the name used by the IFC file, select
an IFC object, right-click and select the Inquire command. Find the
property name in the Inquire object dialog box and copy it.

Create a new property template. Click Lo in the upper-right corner of
Organizer to open the Settings and click Template. Select to create a
blank template and enter Arch_Comments_attribute as the name of the
new template. Save the template.

In Settings, create a new property:
a. Select Custom from the Group list.
b. Then click the Custom button and select Property.
In this example, you will add a Revit Comments property.

c. Enter the word EXTERNAL. in capital letters to the beginning of the
property name in the Property box, then paste or write the property
you copied in the Inquire object dialog box.
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For example, the correct notation could be EXTERNAL. Identity
Data.Comments.

Propertles + Custom~ | Columns

a | Group: [Custom v ‘

. . _ New column
Drag and drop properties from this list to the columns on the right. ;
Assembly Create Property X
EXTERNA
EXTERNZ Name: Revit_Comments
EXTERNA
EXTERNA Property: ‘E)(TERNAL.Identity.DataComments
EXTERNA
EXTERNA Unit type Data type Property type

EXTERNA | No unit - ] |_Text '] [Template -
EXTERMNA

EXTERME
OK  Cancel
EXTERNZ —

d. Click OK, add the new property to the new template, click Modify,
and close Settings.

9. Select the Architectural_Status category. Ensure that Object Browser is
showing the Arch_Comments_attribute grouping information. Right-click
the Architectural_Status category and select Create automated
subcategories to create subcategories using the property values. Create
the subcategories using Grouping in Object Browser and click Modify.

The categories are now as follows:

Categories

—

» [ Project (2329/2329)
~ [ Office Building (2272/2272)
» [] Structural (611/611)
» (1 Architecture (1661/1661)
| Uncategorized (57)
B For Construction [gl]
B No Value (1555)
B Preliminary (43)

You can now automatically track the status of architectural IFC objects in the
Tekla Structures model.

See also
Organizer (page 5)
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Example: Create a custom category for structural design status in Organizer
(page 114)

1.20 Example: Organizer for steel - manage bolts

You can use Organizer to quickly get the quantities of the bolts required for a
project. In addition to the raw quantities, Object Browser lets you group and
sub-total by bolt standard, diameter, and length as well as by where the bolt
will be used (shop or site).

1. To open Organizer, click Manage on the ribbon and then click Organizer.

Click = in the upper-right corner of Organizer to open the Settings .

Click Template to create a new template. Enter Bolt summary as the
template name, select the Blank template option, and click Create to
create the new template.

4. Next, select BOLT from the Group list, and from the available properties
in the list drag the following properties to the Columns:

* TYPE - The bolt standard (for example, 7990, A325, F10T).
* DIAMETER - The nominal diameter of the bolt.

* LENGTH - The nominal length of the bolt.

* SITE WORKSHOP - Where the bolt is to be used.

* NUMBER - The number of bolts in the bolt group.

Set the In sum row show option to - for DIAMETER and LENGTH so that
the result is not shown in the sum row.

You can also add CONTENTTYPE, which shows the type of the object that is
being reported in a row. This is useful for checking the results and
identifying when something other than a bolt is being reported.

Click Modify to save your changes and close the Settings dialog box.

Select some bolts (and optionally other objects as well) in the model.

7. Click & to reload the view in Object Browser to ensure that the latest
information is shown and verify that the bolt information is correctly
reported. At this point, you could edit your Bolt summary template
further to add additional information, such as the main part phase, or
create a custom property to calculate and report the weight of the bolts,
nuts, and washers in the bolt group.

Next, you can use Object Browser to summarize the bolt quantities in
your selection.

8. Click = in Object Browser and select Group.
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10.

11.

12.

13.

a. Dragthe Type column to the grouping row.

You now have a summary of the different types of bolts used in your
selection.

b. Drag the Diameter column and then the Length column to the right
side of Type in the grouping row.

Object Browser now gives you a breakdown of the number of bolts
first by type, then by diameter, and then by length.

You could now also drag the SITE_WORKSHOP column at the end of the
grouping row to further break down the bolts by location, or drag the
column to the beginning of the grouping row to first break down the bolts
by location, then by type, diameter, and length. Other properties could
also be used to group and summarize the bolts.

Customize the template and grouping to suit your needs and click Modify
to save the template. Now you can use the grouping of your template to
categorize all the bolts in the model.

Next, create a new custom category, right-click the category and select
Properties. Enter Bolts as the name of the category.

Define the properties of the category as follows:

a. Ensure that the Include the highest assembly level in the model
check box is not selected.

b. Under Automated object content, click in the rule box for categories
and filters, and select the Object type - Bolt filter from the list of
filters.

Note that the Object type — Bolt filter selects all bolt group
objects including the ones that create only bolt holes as well as studs.

c. Ensure that the Update category at synchronization check box is
selected.

d. Select the Bolt summary property template from the Property
template list.

e. Click Modify.

All bolt objects in the model are now added to the category. In Object
Browser, the properties of the bolts are shown using the Bolt summary
template.

You can now automatically categorize all the bolts in the model using the
same breakdown as in the bolt summary.

Right-click the Bolts category and select Create automated
subcategories.

Click Grouping in Object Browser.

14. Click Modify.
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1.21

You now have a Bolts category which is broken down into a tree based on the
grouping in your Bolt summary template. If any changes are made to the
model, you can simply synchronize this category to automatically update the
breakdown. New bolts will be found and added to the correct subcategories,
or a new subcategory will be created if necessary. For example, if a new bolt
standard or diameter is added to the model, a new subcategory for that bolt
standard or diameter will automatically be created in the tree when you
synchronize the Bolt category with the model.

You could now export the Bolt summary property template, as well as the
Bolts category for use in other projects.

See also
Example: Organizer for steel - manage assemblies (page 120)

Organizer (page 5)

Example: Organizer for steel - manage assemblies

The categories in Organizer can help manage the amount of work for a
project by breaking down the assemblies by phase and assembly type. This
can help in estimating the amount of work required to detail and/or fabricate
the project even before the model has been detailed.

This example assumes that the model has been divided into two or more
phases using Phase Manager. The model could be a design model with no
detailing, or it could be a fully detailed model.

1. To open Organizer, click Manage on the ribbon and then click Organizer.

2. Create a new custom category, right-click the category and select
Properties. Enter Assemblies by phase as the name of the category.

3. Define the properties of the category as follows:

a. Ensure that the Include the highest assembly level in the model
check box is selected.

b. Under Automated object content, click the Select model list and
select the Tekla Structures model to avoid getting any reference
model assemblies to the category.

c. Ensure that the Update category at synchronization check box is
selected.

d. Select the Erection property template from the Property template
list.

e. Click Modify.

The steel assemblies in the model are now added to the category and
their erection information is shown in Object Browser.
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4. Next, click = in Object Browser and select Group:
a. Dragthe Phase (or Phase Name) column to the grouping row.
b. Dragthe Name column to the grouping row.

You can further group by any additional properties you would like to use
to break down the work of each phase.

5. Right-click the Assemblies by phase category and select Create
automated subcategories.

Click Grouping in Object Browser.
Click Modify.

You now have the Assemblies by phase category broken down into
subcategories by phase, then by name.

This now gives you a breakdown of the number and kinds of assemblies in
each phase, which can be used to quickly estimate the amount of work in each
phase. As the model is detailed or changes are made to the project, you can
simply synchronize this category to automatically update the breakdown. This
could be used to track and check the workload of each phase against
production capacity or available resources as the project progresses.

Once detailing has started, the DrawingsFromModel Object Browser
property template could be used to check the availability and status of
drawings for assemblies in each phase.

See also
Example: Organizer for steel - manage bolts (page 118)

Organizer (page 5)

1.22 Example: Organizer for precast

You can use Organizer to view the properties of model objects, for example,
based on custom and standard property types.

1. To open Organizer, click Manage on the ribbon and then click Organizer.
2. Create delivery lot categories DeliveryLot 1..n.

3. Add sequences to the objects in cast units using Task manager or the
Sequencer tool.

For example, if you use the Sequencer tool, enter a sequence name as
the sequence property. The sequence could be the installation sequence.
You can check that the property exists by using the Inquire object
command.

4. C(lick = in the upper-right corner of Organizer to open theSettings .
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10.
11.
12.
13.

14.

15.

16.

17.
18.

19.

Create a new property template for cast units.

Create a custom property for the sequence property:
a. Setthe Data type to Number without decimals.
b. Setthe Property type to UDA.

You can use the Inquire object command to find the sequence property.
Copy the property to the Create Property dialog box in Organizer.

Add the custom property as a new property column to the new property
template.

Set the sorting of the custom property column.

Save the template.

Close the Settings.

Sort the cast units based on the sequence property in Object Browser.
Select the cast units that have the same sequence property.

Select Selected from the Of these rows list at the bottom in Object
Browser.

Select an option from the Result of list, for example, to show the total or
average weight of the selected cast units.

Select a delivery lot category in Categories and add the selected cast units
to the category.

Select the Select objects in the model option from the list at the bottom
in Categories.

Export the selected cast units from Settings to an Excel file.

You can also create property categories to quickly manage object property
data. Create a new property category and open the category properties.

Define the category properties:
a. Enter Fabrication Status as the category name.
b. Select the Tekla Structures model from the list of models.

c. Setthe automatic object content with Organizer filters to select all
precast concrete assemblies in the delivery lot categories.

d. Select the previously created property template.

e. Under Object properties, select the UDA - FABRICATION STATUS
property.
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Category Properties w

Name: |Fabrication Status @

> > Propeity Category
Rules for setting category content

Y Automated object content

Select the model to automatically add objects to this category Model list
Tekla Structures mode| %
l -

Add categories or filters to automatically add objects to this category. WObject group...

¥ Material - Precast concrete

® -
¥ Object type - Assembly »
& -

@ Delivery lot ¥

(@ -]

Automated subcategorics

[#] Include the highest assembly level in the model

% Object properties
Property Type Value Unit

Text - o

[¥] Update category at synchronization

Property template: |Precast Wall List 'l

20. Create automated subcategories based on UDA -
FABRICATION STATUS. Organizer automatically creates categories based
on the properties that are now already in the user-defined attributes of
objects.

You can also create the subcategories manually: Scheduled for
fabrication, In storage, Delivered, and On hold.

21. Now open the subcategory properties and set the type of the property to
Category name for UDA - FABRICATION STATUS.
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% Object properties
Property Inherit Type Value Unit
value

IJ Category name + ||Delivered

22. Now move the uncategorized delivery lot objects between the new
subcategories to easily assign statuses to the objects. Synchronize the
category with the model.

You can also use Object Browser to conveniently overview the statuses
assigned both in the categories and in the object property dialog boxes.

See also
Organizer (page 5)
Sequencer (page 156)
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2 Task Manager

Task manager is a tool for contractors, sub-contractors, and project
managers. Task manager allows you to incorporate time-sensitive data into
3D Tekla Structures models and to control the schedule at various stages and
levels of detail throughout the project.

With Task manager, you can create, store and manage scheduled tasks, and
link the tasks to their corresponding model objects. On the basis of the tasks,
you can create customizable model views and comprehensive 4D simulations
of the progression of the project.

You can create tasks in Task manager or import tasks from external project
management tools such as Microsoft Office Project or Primavera P6. The
import functionality allows you to preserve any schedules that you have
created outside the model environment, and thereby maintain schedule
intelligence and organization. You can supplement imported schedules with
more detail in Task manager.

The above workflow matches what can be found in a normal project delivery -
an increasing awareness of activities that support higher level project
objectives and milestones. Task manager gives you a logical storage space for
this information, and helps you extend schedule control into powerful 3D
representations.

See also

Task manager user interface (page 125)

Create a task in Task manager (page 130)

View and filter tasks in Task manager (page 141)

Import and export tasks and task types in Task manager (page 144)
Print a task schedule from Task manager (page 146)

Example: Visualize a Task manager schedule in the model (page 147)
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2.1 Task manager user interface

Task manager lists all the tasks included in the current Tekla Structures model
and shows the timescale of your project.

To open Task manager, click Manage on the ribbon and then click Tasks.

The tasks and task properties are shown as a task list in a table. Task manager
contains a set of default tasks that depend on the Tekla Structures
environment. The default tasks contain the recommended settings. You can
modify and delete the default tasks.

The Gantt chart shows the timescale of the project using the following

symbols:
Symbol Description

The task i tlinked t del object.

— e task is not linked to any model objec
The task has planned start and end dates.

— P
The task has actual start and end dates.
Shows the completeness of the task.

= P
The task is a summary task.

— ask isasu ary ta
Summary tasks can contain other summary
tasks as subtasks.

Eﬂ Shows the dependency between tasks.

[
Py Shows a milestone.

The task is locked.

i B
The task is marked as locked “ in the task list.

Modify your Task manager view

You can modify the Task manager view to show the relevant task properties
and the timescale.
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To open Task manager, click Manage on the ribbon and then click Tasks.

To Do this
Show or hide o .
the tasks Click = > Task List.
A check mark ¥ in front of Task List indicates that the task
list is shown.
Show or hide e L
the Gantt Click == > Gantt Chart.

chart

A check mark ¥ in front of Gantt Chart indicates that the
Gantt chart is shown.

Show or hide a
task property
in the task list

1.

=

I-':’\-? L
Click === > Task List Items.

2. Select a task property to show or hide it.

A check mark * in front of the property indicates that the
property is shown.

When you open Task manager the next time, the selections
you made in the previous Task manager session are in use.

Show or hide a

1.

v:p\.?" *
task property Click = > Gantt Chart Settings.
I(?hghri Gantt 2. Select a task property to show or hide it.
Note that you must have the actual start and end dates
defined for a task to show them in the Gantt chart.
A check mark * in front of the property indicates that the
property is shown in the Gantt chart.
Change how | Task manager shows the dates and months as set in the
dates and Windows regional and language settings.
month; are 1. Click the Windows Start button.
shown in Task
manager 2. Click Control Panel.
3. Go to the Region and Language settings and select the
format you want to use.
Click OK.
5. Restart Tekla Structures for the change to take effect.
Change the 1. =1 -
Gantt chart Click ~ .
timescale

Task Manager

2. Select a timescale option.
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To Do this

Fit to the project automatically selects the appropriate
timescale option to show the whole project schedule in the
Gantt chart.
You can also change the timescale by dragging the mouse on
the Gantt chart. Hold down the right mouse button and drag
the mouse to the left to make the timescale narrower, and to
the right to make the timescale wider.

Zoominthe |+« Tozoom to ataskinthe Gantt chart, select a task in the

Gantt chart task list and press Ctrl + 1.
+ To zoom to the whole scenario, press Ctrl + 2.
+ To place the Gantt chart symbol of the selected task in the

middle of the chart, press Ctrl + 3.

Change the o .

size of the Click = > Large icons.

buttons in

Task manager

Change the 1.

colors of Gantt
chart symbols

.-:,\..f" -
Click == > Set Colors.

Click the color you want to change.
Select a color.

Click OK.

Keep the Task
manager
dialog box on
top of other
windows on
your screen

W -

Click > Stay on top.

Modify the calendar in Task manager

Task manager has a calendar that is used when calculating the task length.
You can modify the calendar by adding, modifying and removing holidays and
other non-working periods.

Non-working periods change the task duration automatically but they do not
change the planned or actual end dates of a task. This means that the
workload of the task may change. For example, adding an extra non-working
day for a one-week task changes the duration from 5 to 4 days increasing the
workload of one day. Weekends are by default non-working periods.

To open Task manager, click Manage on the ribbon and then click Tasks.

Task Manager
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To

Do this

Set the length of
the working day

Click L T > Non-working Periods....

Type the working hours in the From and To boxes.
Click Set working day.

Click OK.

Add non-working
periods to the
calendar

I

Click L " > Non-working Periods....
Click Add.

Type a descriptive name in the Name box.
Select the Start date and the End date.

v bW

Set the Recurrence frequency to non-recurring,
weekly or yearly.

6. Setthe Range of recurrence for recurrent non-
working periods.

7. Click OK.

To modify a non-working period, select a period in the
Non-working Periods dialog box and click Modify.

To delete a non-working period, select a period in the
Non-working Periods dialog box and click Remove.

Import a holiday
file from Microsoft
Outlook

1. L .
Click - > Non-working Periods....

2. Click Import Holidays....

3. Browse for the holiday file.

4. Select the country from the list.
5. Click OK.

Import a calendar

You can import a calendar from Microsoft Project, for
example.

NOTE The imported calendar overrides the existing
calendar in Task manager.

1. L
Click == > Import....

2. Browse for the file to import.

3. Select the Import calendar option.
Click OK.
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2.2 Create a task in Task manager

You can create scheduled tasks in Task manager and link the tasks to the
relevant model objects. Each task must have at least a name, and a planned
start date and end date. The tasks in Task manager are saved when you save
the Tekla Structures model.

You can create a task both in the model and in Task manager. To open Task
manager, click Manage on the ribbon and then click Tasks.

+ In the model, select one or more model objects, then right-click and select
Task --> Create Task.

The task is automatically linked to the selected model objects.

+ In Task manager, click = .

If you have an existing task selected in Task manager, the properties of the
selected task are used in the new task. You can modify the properties. The
new task is not linked to any model objects yet.

You can create subtasks for a task by clicking &
If the task you created is not shown in Task manager, click anywhere on the
tasks to update the view.

When you have created a task, you can add objects to the task to link the task
to the model, and define the task properties. You can modify the task
properties either in the task list or in the Task Information dialog box. Note
that you can modify some of the properties in the Task Information dialog
box only.

TIP You can lock tasks if you want ensure that task properties are not
unintentionally changed. Select a task, right-click and select Lock task.

Locked tasks are marked with a lock o in the task list.

You can lock one or more tasks at one go. If you select several tasks, and
one or more of the tasks, but not all of them, are already locked, Task

manager shows '+]in front of the Lock task command.

Link a task to the model

Tasks are linked to the model through the objects that are included in the
tasks. You can add objects to a task, copy objects from one task to another,
and remove objects from a task.

To open Task manager, click Manage on the ribbon and then click Tasks.
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To Do this

Add objectsto| 1. In the model, select the objects that you want to add to
a task the task.

2. Do one of the following:
* Right-click and select Task --> Add to Selected Task.

+ In Task manager, right-click the selected task and
click Add Selected Objects.

When you have added the objects to the task, Task manager
changes the color of the task bar to blue in the Gantt chart

=

and selects the Task linked to model check box ¥ in the
task list.

Copy objects | You can copy objects from one task to another in Task

from one task | manager. If you want to move all the objects of a task to

to another another task, you must manually remove the objects from the
original task after the copying.

1. Select the task from which you want to copy the objects.

2. Y
Click -=- to automatically select the objects in the model

to check which objects are linked to the task.
The button changes to II when it is activated.
3. Right-click the selected task and select Keep selection.
All objects linked to the task stay selected.
Select the task you want to copy the objects to.
5. Right-click and select Add selected objects.

Remove 1. Select the task from which you want to remove the
objects from a objects.
task 2

Click - to automatically select the objects in the model.

You can remove all objects from the task, or select which
objects are removed. If you do not select any objects, all
objects are removed from the task.

3. Toremove all the objects from the task:

* In the model, right-click and select Task --> Remove
from Selected Task .

+ In Task manager, right-click the selected task and
click Remove Selected Objects.

4. To remove some objects from the task:
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To Do this

+ In Task manager, right-click the selected task and
select Task Information... --> Objects . Select the
objects you want to remove and press the Delete key.

* Inthe model, select the objects you want to remove,
right-click and select Task --> Remove from Selected
Task .

5. Click the view in the model, and then click the task again
in Task manager to verify that the objects were
successfully removed.

Define a task type

You can define task types for different types of tasks. In the task type, you can
define a production rate and user-defined attributes that are linked to the
objects in the task. You can define task types in advance before creating the
tasks, and then select an appropriate task type when defining the task
properties.

1.

ik W

To open Task manager, click Manage on the ribbon and then click Tasks.

Click L " > Task Types....

Click Add.

Type a name for the task type.

Define a production rate for the task type.

The production rate is used when calculating task duration. Using the
production rate, you can define how many units are produced within a
certain time frame, for example, how many pieces per hour or how large
anareainanhour,1.50 pcs/hour or 8.00 m2/hour. Task manager
automatically calculates the production rate when you define the unit,
quantity, and time.

a. Select a unitin the Unit list.
The default unit is PIECES.

The default task type units are report properties that are listed in the
WorkTypeProperties.xml file. The file is located in the model
folder and it is created when you first open Task manager. The
report properties included in the file depend on the Tekla Structures
environment. To change a task type unit or to add new task types,
edit the WorkTypeProperties.xml file.

You can add Tekla Structures report properties, reference model
properties and calculations to the file. The display name defined in
the file is shown in the Unit column and the report property name
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value is used in Task manager. If you are adding a calculation, the
property type must be calc.

The default units of the task type units depend on the settings in File
--> Settings --> Options --> Units and decimals.

b. Type the quantity in the Quantity box.
c. Type the time in the Time box.

Select the planned dates user-defined attributes which are linked to the
objects in the task.

Click OK.

Define a contractor in Task manager
You can define contractors and assign one contractor for a task.

1.

2
3
4.
5

To open Task manager, click Manage on the ribbon and then click Tasks.

Click L " > Contractors....
Click Add.

Type the contractor name.
Click OK.

Define general task properties

You can define general properties for a task, such as a name, task type, and
contractor.

o Uk N =

To open Task manager, click Manage on the ribbon and then click Tasks.
Select a task in the task list.

Right-click and select Task Information....

Ensure that you are on the General tab.

Type the task name in the Task name box.

Select the Milestone check box if you want to mark the task as a
milestone.

Task manager selects this check box automatically if you set the task
length to zero.

Select how the task is moved in the Gantt chart if it has a dependency with
another task:

«  Only forward moves the dependent task forward only when the
preceding task is moved forward. If the preceding task is moved
backward to an earlier date, the dependent task is not moved.
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+  Forward and backward moves the dependent task in the same
direction as the preceding task, according to the dependency type and
the possible lag time.

8. Select a task type from the Task type list.

If you need to add a new task type, click 9 next to the list and click Add.
Define the task type properties and click OK.

9. Select a contractor from the Contractor list.

If you need to add a new contractor, click D next to the list and click Add.
Type the contractor name and click OK.

10. Click OK.

TIP + You can copy property values in the task list. Right-click a property and select
Copy value. Then select another property, right-click and select Paste value.
You can paste the copied value to multiple tasks.

* You can mark several tasks as milestone tasks at one go. Select the tasks in
the task list, right-click and select Milestone task. Milestone tasks are shown

in the Gantt chart with the milestone symbol \
If you select several tasks, and one or more of the tasks, but not all of them,

are already milestone tasks, Task manager shows D in front of the
Milestone task command.

TIP You can set a default value for how dependent tasks are moved. Click -‘!— T
Task Settings... to select the value. The default value is used in all new tasks.

Define a task schedule

You can plan a schedule for a task. You can define both the start and the end
date, or enter the start date and the task length and let Task manager
calculate the end date.

1. To open Task manager, click Manage on the ribbon and then click Tasks.
2. Select a task in the task list.
3. Right-click and select Task Information....
4. Go to the Scheduling tab.
5. Select the Scheduling mode:
+ Fixed start and end

If you add objects to the task or remove objects from the task, the
production rate changes but the task length does not change.
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TIP

TIP

* Fixed start

If you add objects to the task or remove objects from the task, the task
length changes.

Select the Planned start date.

Select the Planned end date or enter the Planned length of the task.
The planned length is shown in shifts that can be working days, for
example. Go to L T > Non-working Periods... to define a working day.

When you enter the planned length, Task manager calculates the end
date for the task.

If you are using the Fixed start scheduling mode, you can enter the task
length in Planned work duration.

Task manager automatically calculates the total workload, production
rate, and work duration of the task.

Click OK.

You can set a default value for the scheduling mode. Click L " > Task
Settings... to select the value. The default value is used in all new tasks.

You can also modify the length of the task in the Gantt chart. Place the mouse
pointer over the edge of the task bar in the Gantt chart. The mouse pointer
changes into a double-ended arrow. Hold down the left mouse button, and then
drag the edge to the right or to the left.

To check that the dates of subtasks are within the summary task dates, click

L " > Check Dates. The conflicting dates are shown in red.

Manage the planned dates of objects in a task
You can manage the planned duration of the activities related to each object in

a task.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Select a task in the task list.
Ensure that there are objects in the task and that you have defined task
types that are linked to the appropriate user-defined attributes for
planned dates.

3. Right-click and select Task Information....

Go to the Objects tab.
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5. Click the function button to calculate the planned dates for the
objects in the task.

The calculated dates are written to the corresponding user-defined
attributes in the object properties.

6. Click OK.

TIP To calculate the dates for several tasks at one go, select the tasks in the task list

and click .
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Track a task schedule

You can track how a task is progressing by defining the actual schedule and

task completeness information.

1. To open Task manager, click Manage on the ribbon and then click Tasks.
2. Select a task in the task list.

3. Right-click and select Task Information....

4. Go to the Tracking tab.
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5. Select the Completeness tracking mode:
+ Automatic

If there are no objects in the task, Automatic works in the same way
as the Task level tracking mode.

If there are objects in the task, Automatic works in the same way as
the Object level tracking mode.

+ Task level

Define the actual schedule and the task completeness for the task in
Task manager.

* Object level

Define the actual start and end date of individual objects in the object
properties in the model. Task manager calculates the task length and
the task completeness.

When you change the dates of an object in the model, refresh the task
in Task manager to ensure that the changed dates are shown in Task
manager.

6. Click OK.

TIP You can set a default value for the completeness tracking property. Click L T
Task Settings... to select the value. The default value is used in all new tasks.

Define the order of objects in a task
You can define and save the order in which objects are stored in a task.

1. To open Task manager, click Manage on the ribbon and then click Tasks.
Select a task in the task list.

Right-click and select Task Information....

Go to the Objects tab.

Set the sequencing order of objects:

vk wN

a. Click to select all objects in the table, or select the objects that you
want to modify.

b. Click @,
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The Sequencing order column shows the order of the objects.

& Task Information
| General | Scheduling | Tracking| Objects |Dependencies |Additiona| Information|
a9
.
Sequencing Content Object Name Profile Workload
order type type
04 14 | PART Beam COLUMN 4007400
5 15| PART Beam COLUMN 4007400
e 16 |PART ContourPl... |ELEVATE... | 200*25600
7 17 |PART ContourPl... |ELEVATE... | 200"30400
s 18 |PART Beam WALL 3200%160
09 19| PART Beam WALL 3200%160

You can also set the sequencing order by selecting the objects in the

desired order in the model. Select objects in the table, click @ and select
the objects in the model in the desired order.

6. If needed, change the order of the objects in the table:
+ Drag the object rows in the table manually to the desired order.
You can drag several object rows at a time.
+ Click a table column heading to sort the objects.

Press Ctrl and select more than one column heading to sort the
objects by several columns.

7. Click OK.

TIP You can show a sequence in the model.
1. Select the objects in the table.

2. Type the speed of the object selection in seconds in the box next to the

Play E button.

For example, if you enter 2, Tekla Structures waits for 2 seconds until it
selects the next object in the sequence.

3. Click B

The objects are selected in the model in the same order as they are on the
Objects tab. The objects stay selected in the model until you click somewhere in
the model.

TIP To show the order information in the model, select one or more objects in the
table and click *@ or press Ctrl + D. The order information is shown on the
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selected objects in the model. For example, 2-1 means that the object belongs to
the second task in the task list and that the object is the first object in the task.

To clear the numbers from the model, right-click and select Update window.

When you define the cast-in-place work order or work groups within a task, you
can use Organizer for planning the appropriate quantities (page 66) for each
group or lot.

Define a dependency between tasks

You can define different types of dependencies between tasks in Task
manager. You can define a dependency for one task at a time.

The dependencies are represented by arrows in the Gantt chart. The arrow
points to the start or the end of the other task, depending on their
relationship. A task can also be dependent on a milestone.

—

(S

A predecessor is a task that must be completed before the dependent task.
You can also define a lag between the tasks, for example, that Task1 must be
completed five days before Task2 can be started. It is not possible to create
circular dependencies in Task manager.

To define a dependency between tasks:

1. To open Task manager, click Manage on the ribbon and then click Tasks.
2. Select a task in the task list.

3. Right-click and select Task Information....

4. Go to the Dependencies tab.

If you have more than one task selected, the Task Information... tab is
not shown.

5. Select the preceding task from the Task name list.

You cannot select the summary task of the current task, or a task that
already has a dependency with the current task.

6. Select a dependency type from the Type list. The options are:

* Finish-to-Start (FS): The preceding task must finish before the
dependent task can start.

You can also drag a task bar onto another task bar in the Gantt chart to
create a basic Finish-to-Start (FS) dependency with no delay days
between the tasks.

+ Start-to-Start (SS): The preceding task must start before the
dependent task can start.
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* Finish-to-Finish (FF): The preceding task must finish before the
dependent task can finish.

+ Start-to-Finish (SF): The preceding task must start before the
dependent task can finish.

7. If youwant to add a delay between the tasks, enter a value in the Lag list.

Define the value on a scale from 1 to 100. The time unit of the delay is
always days.

8. If needed, go to the General tab and check that the Move with
predecessor setting for how tasks are moved in the Gantt chart is
suitable.

9. Click OK.

TIP You can also modify a dependency in the Gantt chart. Right-click a dependency
arrow and do any of the following:

+ Select a dependency from the list.
+ Enter a new lag value and press the Enter key.

The changes are immediately visible in the Gantt chart.

Define additional information for a task

You can define additional information for a task in Task manager, such as
links to web pages, relevant documents, project schedules, and contracts.

To open Task manager, click Manage on the ribbon and then click Tasks.
Select a task in the task list.

Right-click and select Task Information....

Go to the Additional Information tab.

Click Add.

Select the file and click Open.

Enter additional notes in the Notes box.

Click OK.

© N o Uk~ W N =

Create a scenario

Tasks are included in scenarios. You can create different scenarios to define
alternative workflows, for example, for design, fabrication and erection
schedules to help you in project planning. You can also create separate weekly
scenarios for easier project follow-up.

1. To open Task manager, click Manage on the ribbon and then click Tasks.
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2.3

L
2. Click ==.
3. Click Add.

Task manager names the new scenario as Scenario and adds a running
number to the name, for example Scenario1. You can rename the
scenario.

4. Click Open to add tasks to the new scenario.

=

Click ™ to create a task.
If needed, copy tasks from another scenario.
a. Select ascenario in the list of scenarios and click Open.
b. Select the tasks that you want to copy.
The subtasks of the selected tasks are also copied.
Right-click and select Copy or Copy Without Objects.

d. Go back to the new scenario, select a location for the copied tasks in
the task list, right-click and select Paste.

When you select a location, the copied tasks are placed on the same
level as the selected task. If you do not select any location, the copied
tasks are placed after all existing tasks.

TIP To modify the start dates of the whole scenario at one go, click L T Change
Project Start Date and select a new start date.

To delete a scenario, right-click a scenario in the list of scenarios and click
Delete.

View and filter tasks in Task manager

You can view, select, highlight and filter tasks in different ways in Task
manager.

To open Task manager, click Manage on the ribbon and then click Tasks.

Select tasks

To Do this

Select multiple | Do any of the following:

tasks *  Hold down the Ctrl key and select the tasks.

« Select the first task, hold down the Shift key and select
the last task.
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To

Do this

+ Select the first task and drag the mouse across the tasks
that you want to select.

Select multiple
tasks in the
Gantt chart

Do one of the following:
* Select an area in the Gantt chart.

+ Drag the mouse on the header line in the Gantt chart to
select a time period.

Task manager highlights the tasks that are within the
selected area.

Show only the
selected tasks
in the task list

1. Select one or more tasks in the task list.

2. EE
Click B8

£ |

Click | * | to show all tasks again.

Organize tasks in the task list

To

Do this

Change the
order of tasks

Select a task and click Q or Q until the task is in the
desired location.

You can move more than one task at a time. When you move
a task, the related subtasks are also moved.

Save the order

Click L " and select Save Current Order.

of tasks
If you change the saved order of tasks and want Task
manager to show the saved order again, click L " and
select Return to Saved Order.

Change the Select a task and do one of the following:

hierarchy of
tasks

L] * i
To increase the hierarchy, click |

You can change a task to a subtask.

=T
To decrease the hierarchy, click = .

You can change a subtask to a task.

You change the hierarchy of more than one task at a time.

Expand and
collapse task
hierarchies

Task Manager

Select a task and do one of the following;:

Click Bl to collapse the hierarchy of the selected task.
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To

Do this

[ T

Click = to collapse the hierarchy of all tasks that are on
the same level as the selected task.

Press Ctrl + == to collapse the hierarchy of all tasks.

Click 2] to expand the hierarchy of the selected task.

.;'}...
Click == to expand the hierarchy of all tasks that are on
the same level as the selected task.

:&.L
Press Ctrl + == to expand the hierarchy of all tasks.

Change the
sorting
direction

Click a column heading to change the sorting direction. To
reverse the direction, click the column heading again.

View tasks in the model

To

Do this

Select the
model objects
of a task in the
model

In Task manager:

1. Select a task in the task list.

Click %=,

Highlight a task
in the model

In the model:

1.
Activate the Select tasks Q— selection switch.

2. Place the mouse pointer over a model object. If the
object belongs to a task, Tekla Structures highlights the
task.

The green box shows the boundaries of the task in the
model.

View the tasks
related to a
model object

In the model:

1.
Ensure that the Select tasks @- selection switch is not
active.

2. Select a model object.
3. Right-click and select Task --> Show Related Task .

Task manager selects the related tasks in the task list. The
model objects that belong to the related tasks are
highlighted, but not selected, in the model.
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2.4

Filter tasks

To Do this
Filter tasks in | You can filter tasks by status, contractor, task type, name,
the task list and start and end dates. You can set that the filtering shows
only those tasks that are within your selection in the model.
1. =
Click ===
2. Select the filters you want to use.
3. Click Filter.
4. Click Show all to show all tasks.
You can also filter tasks by entering a filter criterion in the
search box in Task manager. The search covers all the task
properties that are visible in the task list.
TIP You can create filters for tasks using the Tekla
Structures selection and view filter functionality. The
filters control which objects are shown in the model
and which objects can be selected. When you use
selection and view filters, the tasks in the current
scenario are used in the filtering.
See also

Create a task in Task manager (page 130)

Task manager user interface (page 125)

Import and export tasks and task types in Task

manager

You can import and export tasks and task type definitions as . xm1 files in Task

manager.

Import tasks and task types

You can import tasks and task types from external project management
software to Task manager. For example, you can import general building
schedules from Microsoft Project, and further modify them in Task manager.
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To open Task manager, click Manage on the ribbon and then click Tasks.

To

Do this

Import tasks
(page 130)

You can import one task file at a time. The file can contain
more than one task.

1. T
Click == > Import....

Browse for the file to import.

Select Import baseline dates to planned dates to
import the baseline dates of tasks as the planned dates.

By default, scheduled dates are imported to Task
manager as planned dates.

4. Select how the tasks are imported to Task manager:

+ Append imported tasks to scenario adds the
imported tasks at the end of the task list.

+ Override existing tasks replaces the existing tasks
with the imported tasks.

The links between the existing tasks and model
objects are not modified. Task dependencies are
imported.

+ Override selected properties of existing tasks
imports task properties.

When you select this option, Task manager displays a
list where you can select the properties.

The links between the existing tasks and model
objects are not modified. Task dependencies are
imported.

5. Click OK.

Imported tasks are marked as imported = and locked ¥ in
Task manager.

Import task

types
(page 130)

You can import one task type file at a time. The file can
contain more than one task type.

1. -
Click L > Task Types....

2. Click Import....
3. Browse for the file to import.
Select how the task types are imported to Task manager:

« Override task types using the same name replaces
the existing task types that have the same task type
name as the imported task types.
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2.5

To

Do this

5.

+ Append imported task types adds the imported task
types at the end of the task type list.

Click OK.

Export tasks and task types
You can export tasks and task types from Task manager to external project
management software.

To open Task manager, click Manage on the ribbon and then click Tasks.

To

Do this

Export tasks

L

Click == > Export....

Browse for the file to export.
Click Save.

Task dependencies are exported.

If the tasks contain only planned dates, they are exported
as scheduled dates. If the tasks contain planned dates
and actual dates, the planned dates are exported as
baseline dates and the actual dates as scheduled dates.

Export task
types

Click L " > Task Types....
Click Export....
Browse for the file to export.

Click Save.

Print a task schedule from Task manager

You can print task schedules from Task manager. By default, the schedule is
printed from the first date to the last date that is visible in the Gantt chart.

1. To open Task manager, click Manage on the ribbon and then click Tasks.

2. Click ™=,

3. Select the suitable printing options:

+ Click Page setup... to modify the page settings.

+ Select Print to the project end date to print the whole schedule even
if the end date is not visible in the Gantt chart.
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2.6

+ Select Adjust to percent of normal size or Fit to pages according to
your needs.

4. If needed, click Print Preview... to view how the schedule is printed.
You can print the schedule from the Print preview... dialog box.

5. Click Print... to print the schedule.

6. Modify the printer settings if needed.

7. Click Print.

TIP You can create reports from the task information in Task manager and list
various details about the tasks, such as the task name, task type, planned and
actual dates, and task completeness.

See also
Create a task in Task manager (page 130)

Example: Visualize a Task manager schedule in the
model

You can use the Project Status Visualization tool to review the task
schedules created in Task manager.

In this example, you will first create object groups to define which tasks are
shown in the model. The object groups are related to the current Task
manager scenario. You will then create object representation settings to
define how the tasks are shown in the model. Finally, you will review the task
schedule using the Project Status Visualization tool.

1. Create object groups for tasks:
a. InTekla Structures, go to the View tab and click Representation.
b. Click Object group....

c. Inthe Object Group - Representation dialog box, create an object
group with the following settings:

= 'l Category Property Condition Value
v - Task Planned start date  Earlier than Review date
v - Task Planned end date  Earlier than Review date

d. Enter a name for the group, for example Completed, in the box next
to the Save as button, and then click Save as.

e. Repeatsteps 1c-d to create an object group called Started. Use the
following settings:
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h.

- ( Category Property Condition Value
v - Task Planned start date  Earlier than Review date

V| - Task Planned end date  Later than or equ.. Review date

Repeat steps 1c - d to create an object group called NotStarted. Use
the following settings:

=0 Category Property Condition Value
v - Task Planned start date  Later than Review date
v - Task Planned end date  Later than Review date

Repeat steps 1c- d to create an object group called A11. Use the
following settings:

- { Category Property Condition Value
v - Part Mame Equals
Click Close.

Create object representation settings for tasks:

a.

f.

In the Object Representation dialog box, select the object group
Completed from the list in the Object group column.

In the Color column, select a color for the object group, for example
blue.

In the Transparency column, select a transparency setting for the
object group, for example Visible.

Click Add row to add a new row.

Repeat steps 2a - d to define the color and transparency settings for
the other object groups (Started, NotStarted, and A11).

For example, you can use the following settings:

Object group Color Transparency
Completed E—— Visible

Started = Visible
MNotStarted = 90% transparent
All E— 50% transparent

Enter a name for the object representation settings, for example
Tasks, and then click Save as.

Click OK.

Review the task schedule using Project Status Visualization:

a.
b.

In Tekla Structures, go to the Manage tab and click Project status.
Select Tasks from the Object representation list.
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c. Click the step buttons to change the Review date and to view the
changes in the model.

See also

Create a task in Task manager (page 130)
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3 Phase Manager

Use Phase Manager to break a model up into sections.

Phases are often used to indicate erection sequences. You can create reports
and views, hide and lock objects, and copy objects from other models,
according to their phase number.

For example, you might have a large project which several users work on
simultaneously in single-user mode. First create a basic model that includes,
for example, the columns. This is phase 1. You then copy this basic model to all
users.

Each user then works on a separate part of the building. When a part of the
model is completed, you can copy it back to the basic model as a separate
phase (phase 2, 3, etc.).

NOTE When you copy objects between models using phases, the target model must
have been created using the same or a newer version of Tekla Structures as
the source model. You cannot copy from a newer version to an older version.

3.1 Divide the model into phases
1. Onthe Manage tab, click Phases.
The Phase Manager dialog box appears.
2. Click Add to create new phases.
3. Click Set current to make the selected phase the current phase.

From now on, Tekla Structures assigns all objects you create to the current
phase. The @ character in front of the phase number indicates the current
phase.

4. Divide the model into phases.
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a. Toidentify the phase of an object, select an object and click Phases
by objects.

Tekla Structures selects the phase of the object.

b. To see which objects belong to a certain phase, select a phase from
the list and then click Objects by phases.

Tekla Structures highlights the corresponding objects in the model.

c. Tochange the phase of one or more objects, select the objects, select
a phase from the list, and then click Modify phase.

5. Click OK to save your changes.

3.2 Lock and unlock objects in specific phases

3.3

To protect model objects from being accidentally modified or deleted, you can
lock them. For example, you can lock parts, bolts, welds, and reference models
in a Tekla Structures model according to their phase.

When an object is locked, you cannot modify its properties or delete it. You can
only change the object’s user-defined attributes that do not affect numbering.
If you try to modify or delete a locked object, Tekla Structures displays the
following warning message:

"There are locked objects, see report. The operation could not be performed."
1. On the Manage tab, click Phases.

2. Inthe Phase Manager dialog box, select the phases whose objects you
want to lock or unlock.

3. Do one of the following;:
+ To lock objects, click Lock objects.

Tekla Structures sets the user-defined attribute Locked to Yes for the
objects in the selected phases.

+ To unlock objects, click Unlock objects.

Tekla Structures sets the user-defined attribute Locked to No for the
objects in the selected phases.

For information on how to protect model objects from being accidentally
modified in the multi-user mode, see Access rights in multi-user mode.

Define custom phase properties

You can add custom phase properties, which will appear as extra columns in
the Phase Manager dialog box.
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Define the names of phase properties in the objects. inp file. To use phase
properties in reports and templates, use the syntax PHASE . ATTRIBUTE NAME
in the phase property field name.

The default objects. inp file contains a Phase attributes section with syntax
examples. For more information, see Properties of the objects.inp file.
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4 Lotting

4.1

With lots you can group assemblies for transporting to site. Lotting means that
you evaluate specific model parts with respect to the number of units that can
be carried by a transfer vehicle.

For example, you can calculate how many concrete truck deliveries are needed
to pour the footings or slabs for a specific portion of the model. With this
information, it is easier to determine area requirements and create an erection
schedule.

When you define lots, you must take into account the load-carrying capacity of
the vehicle, because a lot cannot exceed the maximum total load capacity. You
can calculate truck load sizes based on material weights and model quantities.
For most model parts, the weight is based on the size, length, and material of
the part.

TIP To view the properties of a part, double-click the part, or click Inquire object
?
B and select the part.

You can use lotting in conjunction with the Sequencer tool. For example, you
can load each part of the model onto a specific truck based on the erection
sequence of the part.

The basic lotting process is the same for steel and concrete parts. However, if
you are using cast-in-place concrete, remember that the concrete is
transported in a volumetric container (for example, in a ten-cubic-yard truck).
In that case, you must calculate the weight-carrying capacity of the concrete
vehicle before defining the number of lots.

Create a lot
Create lots to group assemblies for transporting to a site.

1. Onthe Manage tab, click Lotting.
2. Click Properties... to display the Lot Properties dialog box.
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Enter a name in the box at the bottom of the dialog box.
Enter a lot number in the Number box.

Enter the maximum weight of the lot in the Max weight box. The units
depend on the settings in File menu --> Settings --> Options --> Units
and decimals .

Click Add.

Tekla Structures creates an empty lot with the defined properties.

4.2 Add parts to a lot

After you have created the needed lots, you must select each part of the
model and assign them to a lot until the total load weight of the lot reaches
the specified target.

1.
2.

On the Manage tab, click Lotting.
Select an existing lot from the list.

Tekla Structures highlights the parts included in the lot. The total weight of
the lot and the number of assemblies it contains are displayed under
Applied values.

Hold down Shift and select the parts that you want to add to the lot.
Click Apply selected.

The weight and the number of added parts are displayed under Current
values. Tekla Structures displays a warning message if the weight limit of
the lot is exceeded.

Click OK to close the dialog box.

When you re-open the dialog box, the Applied values include the weight
and the number of parts you added.

WARNING Parts can belong only to one lot at a time. If you add parts that are

already in an another lot, the parts will be removed from that lot.

4.3 Remove parts from a lot

1.
2.

On the Manage tab, click Lotting.
Select an existing lot from the list.
Tekla Structures highlights the parts included in the lot.

Hold down Ctrl and select the parts that you want to remove from the lot.
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If you want to remove all the parts from the lot, click somewhere in the
model without holding down Ctrl.

Tekla Structures deselects the parts.
Click Apply selected.
5. Click OK to close the dialog box.

4.4 Delete a lot
1. Onthe Manage tab, click Lotting.
2. Click Properties....
3. Select an existing lot from the list.
4. Click Delete.

Lotting 155 Delete a lot



5 Sequencer

Use the Sequencer tool to create sequences and to assign incremental
numbers to parts.

You can define several sequences for different purposes, and a part can
belong to several sequences at the same time. For example, you can create
erection sequences to define the order in which to erect parts.

Sequencer works by assigning a sequence number to a user-defined attribute
(UDA) of a part. If you want to view and modify the sequence numbers
afterwards, you must first create a new user-defined attribute to which you
assign the sequence numbers.

Limitations

Sequencer does not work for objects that are inside a reference model.

5.1 Create a sequence

1.

First, create a user-defined attribute (UDA) to which you assign sequence
numbers.

In the objects.inp file, search for the part attributes section to add a
new user-defined attribute (UDA). The value type mustbe integer,
and the field format mustbe &d.

For example:

attribute ("SEQUENCE 1", "Sequence 1", integer, "3%d", no,
none, "0.0", "0.0")

In Tekla Structures, go to the Manage tab and click Sequencer.
The Sequencer Properties dialog box opens.

In Sequence name, enter the name of the sequence. The sequence name
has to be exactly the same as the name of the UDA defined in the
objects.inp file.

For example, SEQUENCE 1.
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Click Apply.
Select the parts you want to include in the sequence.

The first part gets the sequence number 1, the second part number 2, and
so on.

The Sequencer Properties dialog box lists the sequences that you have
entered in the Sequence name box. Max number shows the highest
number that is in use in the selected sequence.

Max number

Sequence name | SEQUENCE_2 |[10 |

SEQUENCE 1
SEQUENCE 2
SEQUENCE_3

If you select a part that has already been included in the sequence, Tekla
Structures asks if you want to override the existing number. If you click
Yes, Tekla Structures gives the next available number to the part.

To finish adding parts to the sequence, right-click and select Interrupt or
press Esc.

5.2 Add parts to a sequence

You can add new parts at the end of an existing sequence. If you want to add
parts in the middle of the sequence, you must redefine the whole sequence.

5.3

1.

vk W

On the Manage tab, click Sequencer.

Select a sequence name from the list.

Click OK or Apply.

Select the parts you want to add to the sequence.

To finish adding parts to the sequence, right-click and select Interrupt or
press Esc.

Check the sequence of a part

You can check the sequence name and number of a part by using the Inquire
object command.

1.
2.

2
On the ribbon, click Inquire object __

Select a part.
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Tekla Structures displays the properties of the part. The sequence name
and number are displayed under More. For example:

More:
Sequence 1 4
Sequence 2 - 10

5.4 Modify the sequence number of a part

You can modify the sequence number that has been assigned to a user-
defined attribute (UDA) of a part.

1.
2.

Double-click a part to open the part properties in the property pane.
Click More.

The current sequence number is displayed next to the UDA to which you
assigned the sequence number. For example, Ssequence 1.

Modify the sequence number.
Click Modify.

5.5 Delete a sequence

1.
2.
3.

On the Manage tab, click Sequencer.
Select a sequence name from the list.
Click Delete and then click Yes.

Sequencer 158 Modify the sequence number of a part



6 Project status visualization

Use the Project Status Visualization tool to review the status of model
objects in a specific time frame.

For example, you can use Project Status Visualization to display the erection
schedule for groups of parts using different colors, and to identify the parts
that are scheduled to be fabricated during a specific time period.

Before you can create project status visualizations, you need to define some
color and transparency settings that include object groups based on date
rules.

You can also define tasks for parts and assemblies using Task manager. The
project status visualization can then be based on tasks (page 147).

6.1 Create a visualization

Create visualization settings to view the project status of model objects in a
specific time frame.

1. Onthe Manage tab, click Project status to open the Project Status
Visualization dialog box.

2. Modify the visualization settings.

a. Inthe Object representation list, select one of the predefined object
representation settings.

b. Define a start and end date for the time scale slider.

c. Define the length of the time step.

Select the Refresh view automatically check box.

Enter a unique name in the box next to the Save as button.

Click Save as to save the visualization settings.

o v kW

To view the visualization in the model, click the step buttons.
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6.2 Copy visualization settings to another model

You can copy project status visualization settings to another model. The
visualization settings files are located in the model's \attributes folder, and
they have the file name extension . 4d.

1. Inthe model's \attributes folder, select the visualization settings you
want to copy.

2. Select where you want to copy the settings.

+ To make the settings available in another model, copy them to the
\attributes folder of the destination model.

+ To make the settings available in all models, copy them to the project
or firm folder, defined by the advanced option XS PROJECT or
XS _FIRM.

3. Include a copy of the object representation settings file (. rep) and object
group files (. PObjGrp) in the \attributes, project, and firm folders to
ensure that all the files will work correctly.

4. Restart Tekla Structures.

6.3 Delete visualization settings

Delete the project status visualization settings that have been created using
the Project Status Visualization tool.

1. Delete the visualization settings file located in the model's \attributes
folder.

Project status visualization settings have the file name extension . 4d.

2. Restart Tekla Structures.

6.4 Project status visualization example: Visualize the
erection schedule of a project

This example shows how to visualize erection schedules using the Project
Status Visualization tool.

1. Define an erection schedule for parts using the Planned start user-
defined attribute.

a. Double-click a part to open the part properties in the property pane.
b. Click UDAs.
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c. Onthe Workflow tab, modify the value of the Planned start user-
defined attribute in the Erection section.

ERECTION
Planned start | 0211.2011 El
d. Select the Planned start check box.
e. Ensure that all other check boxes are cleared.
f.  Select all the parts for which you want to use the same erection date.

TIP To make it easier to select parts, create a separate selection
filter for each group of parts.

g. Click Modify.
h. Repeat the steps for each group of parts in your model.
You can use a different erection date for each group of parts.

Select objects for the visualization by creating an object group that defines
which objects are shown in the model during the visualization.

a. Onthe View tab, click Representation to open the Object
Representation dialog box.

b. Click Object group... to open the Object Group - Representation
dialog box.

c. Create an object group that includes all objects whose Planned start
user-defined attribute is earlier than or equal to the review date.

Define the following settings:

+ Inthe Category list, select Object.

* Inthe Property list, select PLANNED START E.

* In the Condition list, select Earlier than or equal.

+ Inthe Value list, select Select date....

* Inthe Select Date dialog box, select Review date and click OK.

d. Inthe box next to the Save as button, enter a name for the group. For
example, plan same or before review date.

e. Click Save as.

( Categary Property Condition Value
Object PLANMED_START_E  Earlier than or equal Review date

Define the color and transparency of the selected objects using color and
transparency settings that define how the objects are shown during the
visualization.
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a. Onthe View tab, click Representation to open the Object
Representation dialog box.

b. Define color and transparency settings for the object group that you
created in step 2:

+ Click Add row.

+ Inthe Object group list, select the object group you just created.
+ Inthe Color list, select Color by class.

+ Inthe Transparency list, select Visible.

c. Define another set of color and transparency settings to hide the rest
of the parts from the model:

+ Click Add row.

* Inthe Object group list, select the object group A11.
+ Inthe Color list, select Color by class.

+ Inthe Transparency list, select Hidden.

d. Inthe box next to the Save as button, enter a name for the settings.
For example, planned start erection date.

e. Click Save as.

Dbject group Color Tranzparency

plan_same_or_before_review_date  Color by clase  Wizible
All Color by clazs Hidden

Define a time period for the visualization.

a. Onthe Manage tab, click Project status to open the Project Status
Visualization dialog box.

b. Define the length of the time step.
Define a start and end date for the time scale slider.

d. Inthe Object representation list, select the object representation
setting you created in step 3.

e. Select the Refresh view automatically check box.

f.  Inthe box next to the Save as button, enter a name for the
visualization.

g. Click Save as to save the visualization settings.
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Review

Review date: 02.11.2011 B

Step backward or forward:

“ < | ‘ = | 3

Or select date on the time scale;

Scale start:
02112011 [-]

Object representation: planned_start_erection_date

| Refresh view automatically

day(s)

;
Scale end:
30112011 [

A Edit...

5. View the erection schedule using the Project Status Visualization tool.

a. Onthe Manage tab, click Project status to open the Project Status

Visualization dialog box.

b. Inthe list next to the Load button, select the visualization setting you

created in step 4.
Click Load.

d. To view the visualization in the model, click the step buttons.

The images below show how the objects are shown when you change

the review date:

Review date Visualization
B 1
Ao T3
17 e 4,
2] e P
3 T R
4:-=:_ } . A . ?
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November 02
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Review date Visualization
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November 05

November 08

November 11
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Review date Visualization

November 14

November 17
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Review date Visualization

November 20
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7 Disclaimer

© 2019 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced
Software. Use of the Software, and use of this Software Manual are governed
by a License Agreement. Among other provisions, the License Agreement sets
certain warranties for the Software and this Manual, disclaims other
warranties, limits recoverable damages, defines permitted uses of the
Software, and determines whether you are an authorized user of the Software.
All information set forth in this manual is provided with the warranty set forth
in the License Agreement. Please refer to the License Agreement for important
obligations and applicable limitations and restrictions on your rights. Trimble
does not guarantee that the text is free of technical inaccuracies or
typographical errors. Trimble reserves the right to make changes and
additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by
international treaties. Unauthorized reproduction, display, modification, or
distribution of this Manual, or any portion of it, may result in severe civil and
criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tekla Civil, Tedds, Solve,
Fastrak and Orion are either registered trademarks or trademarks of Trimble
Solutions Corporation in the European Union, the United States, and/or other
countries. More about Trimble Solutions trademarks: http://www.tekla.com/
tekla-trademarks. Trimble is a registered trademark or trademark of Trimble
Inc. in the European Union, in the United States and/or other countries. More
about Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other
product and company names mentioned in this Manual are or may be
trademarks of their respective owners. By referring to a third-party product or
brand, Trimble does not intend to suggest an affiliation with or endorsement
by such third party and disclaims any such affiliation or endorsement, except
where otherwise expressly stated.

Portions of this software:

D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights
reserved.
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EPM toolkit © 1995-2006 Jotne EPM Technology a.s., Oslo, Norway. All rights
reserved.

Open Cascade Express Mesh © 2015 OPEN CASCADE S.A.S. All rights reserved.
PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved.
FLY SDK - CAD SDK © 2012 Visuallntegrity™. All rights reserved.

Teigha © 2002-2016 Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

FlexNet Publisher © 2014 Flexera Software LLC. All rights reserved.

This product contains proprietary and confidential technology, information
and creative works owned by Flexera Software LLC and its licensors, if any. Any
use, copying, publication, distribution, display, modification, or transmission of
such technology in whole or in part in any form or by any means without the
prior express written permission of Flexera Software LLC is strictly prohibited.
Except where expressly provided by Flexera Software LLC in writing,
possession of this technology shall not be construed to confer any license or
rights under any Flexera Software LLC intellectual property rights, whether by
estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures,
click File menu --> Help --> About Tekla Structures and then click the 3rd
party licenses option.

The elements of the software described in this Manual are protected by
several patents and possibly pending patent applications in the United States
and/or other countries. For more information go to page http://
www.tekla.com/tekla-patents.
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